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1 HP Deskjet F2200 All-in-
One series Help

For information about the HP All-in-One, see:

* HP All-in-One overview

* Find more information

e Howdol?

*  Connection information

* Load originals and load paper
*  Print from your computer

* Use the copy features

» Use the scan features

* Maintain the HP All-in-One
»  Shop for ink supplies

* HP warranty and support

»  Technical information

B NOTE: If you are using the product with a Windows 2000 computer, some features
may not be available. For more information, see Notice to Windows 2000 users.
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2 HP All-in-One overview

The HP Deskjet F2200 All-in-One series is a versatile device that enables easy-to-use
copying, scanning, and printing.
Copy

The HP All-in-One allows you to produce high-quality color and black-and-white copies
on a variety of paper types. You can enlarge or reduce the size of an original to fit a
specific paper size, adjust the copy quality, and make high-quality copies of photos.

Scan

Scanning is the process of converting text and pictures into an electronic format for your
computer. You can scan almost anything (photos, magazine articles, and text documents)
on the HP All-in-One.

Print from your computer

The HP All-in-One can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.

This section contains the following topics:
* The HP All-in-One at a glance

*  Control panel buttons

» Status light overview

* Use the HP Photosmart software

The HP All-in-One at a glance
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Label Description
1 Control panel
2 Input tray

HP All-in-One overview 9



Chapter 2
(continued)

Label Description

Tray extender

Paper-width guide

Print cartridge door

Lid backing

Rear access door

3
4
5
6 Glass
7
8
9

Rear USB port

10 Power connection’

*  Use only with the power adapter supplied by HP.

Control panel buttons
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P8 Label Icon Name and Description

[1’]

= 1 On: Turns the HP All-in-One on or off. The On button is lit when the HP All-
in-One is powered on. The light blinks while performing a job.

When the HP All-in-One is off, a minimal amount of power is still used by the
device. To completely disconnect the power supply to the HP All-in-One, turn
the device off, and then unplug the power cord.

CAUTION: Before you unplug the power cord, you must press the On
button and allow the HP All-in-One to turn itself off. This prevents the print
cartridges from drying out.

2 “G Check Print Cartridge lights: Indicates the need to reinsert the specified print
cartridge, replace the print cartridge, or close the print cartridge door. The
6 Black/Photo light indicates that the problem is with the black or photo print

10 HP All-in-One overview



(continued)

Label Icon Name and Description
cartridge, and the Color light indicates that the problem is with the tri-color
print cartridge.

3 X Cancel: Stops a print, copy, or scan job.
A blinking Paper light next to the Cancel button indicates the need to load
paper or clear a paper jam. Press any button after a problem is solved to
instruct the HP All-in-One to continue.

4 Scan: Starts scanning the original currently on the glass. The Scan command

= is ignored if the HP All-in-One is busy with any other job. The Scan command
— functions only when the computer is on.
5 Paper Type: Changes the paper type setting to either plain or photo paper.
B Make sure the appropriate paper type is loaded in the input tray. The default
D paper type setting is Plain Paper.

The Paper Type lights indicate the currently selected paper size and type:
«  Plain Paper: Letter and A4 paper
»  Photo Paper (Large): Letter and A4 photo paper
»  Photo Paper (Small): 10 x 15 cm (4 x 6 inch) photo paper

6 @ Start Copy Black: Starts a black-and-white copy job.
Press this button multiple times to specify multiple black copies. The printer
will start printing shortly after the number of copies have been selected. The
number of copies to be printed is shown to the right of this button.
TIP: The maximum number of copies you can make using the control panel
is 9 (varies by model). To make more copies at once, use the HP Software.
When initiating multiple copies of an original from the software, only the last
digit of the number of copies is represented on the control panel. For
example, if you are making 25 copies, the number 5 appears on the display.

7 Start Copy Color: Starts a color copy job.

Press this button multiple times to specify multiple color copies. The printer
will start printing shortly after the number of copies have been selected. The
number of copies to be printed is shown to the right of this button.

TIP: The maximum number of copies you can make using the control panel
is 9 (varies by model). To make more copies at once, use the HP Software.
When initiating multiple copies of an original from the software, only the last
digit of the number of copies is represented on the control panel. For

example, if you are making 25 copies, the number 5 appears on the display.

Control panel buttons 11
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Status light overview

Several indicator lights inform you of the status of the HP All-in-One.

:
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) wﬂ

|

Label Description

1 On light

2 Check Print Cartridge lights

3 Paper light

4 Paper Type lights (for the Paper Type button)

The following table describes common situations and explains what the lights mean.

=4 Light status What it means
b
' All lights are off. The HP All-in-One is turned off. Press the On button to turn on the device.
?O The On light and one of the Paper | The HP All-in-One is ready for printing, scanning, or copying.
3 Type lights are on.
% The On light is blinking. The HP All-in-One is busy printing, scanning, copying, or aligning the
3 print cartridges.
s
2 The On light blinks quickly for 3 You pressed a button while the HP All-in-One is already busy printing,
seconds and then is on steady. scanning, copying, or aligning the print cartridges.
The On light blinks for 20 seconds | You pressed the Scan button and there was no response from the
and then is steady. computer.
The Paper light is blinking. »  The HP All-in-One is out of paper.

e The HP All-in-One has a paper jam.

= The paper size setting in the copy software does not match the paper
size detected in the input tray.

The Check Print Cartridge light is The print cartridge door is open.
blinking. «  The print cartridges are missing or not seated correctly.
= The tape was not removed from the print cartridge.

12 HP All-in-One overview



(continued)

Light status

What it means

«  The print cartridge is not intended for use in this HP All-in-One.
«  The print cartridge might be defective.
«  The print cartridge is low on ink.

The On, Paper, and Check Print
Cartridge lights are blinking.

Scanner failure. For more information, see Scan fails.

Turn off the HP All-in-One, then turn it on again. If the problem persists,
contact HP Support.

NOTE: HP All-in-One will still operate as a printer.

All lights are blinking.

The HP All-in-One has a fatal error.

1. Turn the HP All-in-One off.

2. Unplug the power cord.

3. Wait a minute, then plug the power cord back in.
4. Turn the HP All-in-One back on.

If the problem persists, contact HP Support.

Use the HP Photosmart software

The HP Photosmart Software provides a fast and easy way to make prints of your photos.
It also provides access to other basic HP imaging software features, such as saving and

viewing your photos.

For more information on using the HP Photosmart Software:

«  Check the Contents panel on the left. Look for the HP Photosmart Software Help
contents book at the top.

« If you do not see the HP Photosmart Software Help contents book at the top of the
Contents panel, access the software help through the HP Solution Center.

BY NOTE: The HP Photosmart software supports the following file formats: BMP, DCX,
FPX, GIF, JPG, PCD, PCX, TIF, PICT, PSD, PCS, EPS, TGA, SGI, PDF, and PNG
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3 Find more information

You can access a variety of resources, both printed and onscreen, that provide
information about setting up and using the HP All-in-One.

Setup Guide

The Setup Guide provides instructions for setting up the HP All-in-One and
installing software. Make sure you follow the steps in the Setup Guide in order.

% If you have problems during setup, check the Setup Guide for troubleshooting
_ information, or see Troubleshooting in this onscreen Help.

Basics Guide

The Basics Guide contains an overview of the HP All-in-One, including step-
by-step instructions for basic tasks, troubleshooting tips, and technical
information.

HP Photosmart animations

The HP Photosmart animations, located in the relevant sections of the onscreen
Help, show you how to complete key tasks on the HP All-in-One. You will learn
how to load paper and other media, replace the print cartridges, and scan
originals.

Onscreen Help

The onscreen Help provides detailed instructions on using all features of the
HP All-in-One.

«  The How Do I? topic provides links so you can quickly find information on
performing common tasks.

«  The The HP All-in-One overview topic provides general information about
the main features of the HP All-in-One.

«  The Troubleshooting topic provides information about resolving errors
you might encounter with the HP All-in-One.

Readme
The Readme file contains the most recent information which might not be found
in other publications.

Install the software to access the Readme file. For more information, see View
the Readme file.

www.hp.com/support If you have Internet access, you can get help and support from the HP Web
site. This Web site offers technical support, drivers, supplies, and ordering
information.
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4 Howdol?

This section contains links to commonly performed tasks, such as printing photos and
optimizing your print jobs.

* How do | change the print settings?

* How do | print borderless photos on 10 x 15 cm (4 x 6 inch) paper?
* How do | load envelopes?

» How do | scan using the control panel?

* How do | get the best print quality?

* How do | print on both sides of the paper?

» How do | replace the print cartridges?

* How do | align the print cartridges?

* How do | clear a paper jam?

How do 1?

How do 1? 17
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5 Connection information

The HP All-in-One comes equipped with a USB port so you can connect directly to a
computer using a USB cable. You can also share the product over an existing home

network.

This section contains the following topics:

* Supported connection types

e Use printer sharing

Supported connection types

The following table contains a list of supported connection types.

Description

Recommended number
of connected
computers for best
performance

Supported software
features

Setup instructions

USB connection

One computer connected
with a USB cable to the
rear USB 1.1 full speed
peripheral connection
port on the HP All-in-One.

All features are
supported.

Follow the Setup Guide
for detailed instructions.

Printer sharing

Up to five.

The host computer must
be on at all times in order
to print from the other
computers.

All features resident on
the host computer are
supported. Only printing
is supported from the
other computers.

Follow the instructions in
Use printer sharing.
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Use printer sharing

If your computer is on a network, and another computer on the network has an HP All-
in-One connected to it by a USB cable, you can print to that printer using printer sharing.

The computer directly connected to the HP All-in-One acts as the host for the printer and
has full software functionality. The other computer, which is referred to as a client, has
access only to the print features. You must perform other functions from the host
computer or from the control panel on the HP All-in-One.

To enable printer sharing on a Windows computer

A Refer to the user guide that came with your computer or see the Windows onscreen
Help.

Connection information 19
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6 Load originals and load paper

You can load many different types and sizes of paper in the HP All-in-One, including letter
or A4 paper, photo paper, transparencies, and envelopes.

This section contains the following topics:

* Load originals
* Choose papers for printing and copying

* Load paper

Load originals
You can copy or scan up to letter- or A4-size originals by loading them on the glass.

To load an original on the glass
1. Lift the lid on the HP All-in-One.

2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.

X TIP: Formore help on loading an original, refer to the engraved guides along the
edge of the glass.

TIP: To getthe correct copy size, make sure that there is no tape or other foreign
object on the glass.
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3. Close the lid.

Choose papers for printing and copying

You can use different types and sizes of paper in the HP All-in-One. Review the following
recommendations to get the best printing and copying quality. Whenever you change
paper types, remember to change the paper type settings. For more information, see Set
the paper type for printing.

Load originals and load paper 21
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Chapter 6

This section contains the following topics:

Recommended papers for printing and copying
Recommended papers for printing only

Papers to avoid

Recommended papers for printing and copying

If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. If you are printing photos, for example,
load HP Premium or HP Premium Plus photo paper in the input tray.

The following is a list of HP papers you can use for copying and printing. Depending on
your country/region, some of these papers might not be available.

Bf NOTE: To achieve a borderless print, you must use 10 x 15 ¢cm (4 x 6 inch) paper
with tab. The HP All-in-One prints to the edge of three sides of the paper. When you
remove the tab from the fourth side, you have a borderless print.

HP Premium Plus Photo Paper

HP Premium Plus Photo Papers are the best HP photo papers, with image quality and
fade resistance superior to store-processed photos. They are ideal for printing your high-
resolution images for framing or including in a photo album. These papers are available
in several sizes, including 10 x 15 cm (4 x 6 inch) (with or without tabs), A4, and 8.5 x 11
inch sizes for printing or copying photos from the product.

HP Premium Photo Paper

HP Premium Photo Papers are high-quality, glossy-finish or soft gloss-finish photo
papers. They look and feel like store-processed photos and can be mounted under glass
or in an album. These papers are available in several sizes, including 10 x 15 cm (4 x 6
inch) (with or without tabs), A4, and 8.5 x 11 inch sizes for printing or copying photos from
the product.

HP Premium Inkjet Transparency Film

HP Premium Inkjet Transparency Film make your color presentations vivid and even more
impressive. This film is easy to use and handle and dries quickly without smudging.

HP Premium Inkjet Paper

HP Premium Inkjet Paper is the ultimate coated paper for high-resolution usage. A
smooth, matte finish makes it ideal for your highest-quality documents.

HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers.
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HP All-in-One Paper or HP Printing Paper

«  HP All-in-One Paper is specifically designed for HP All-in-One products. It has an
extra bright blue-white shade that produces sharper text and richer colors than
ordinary multifunction papers.

« HP Printing Paper is a high-quality multifunction paper. It produces documents that
look and feel more substantial than documents printed on standard multipurpose or

copy paper.
To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,

choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.

BY NOTE: Atthis time, some portions of the HP Web site are available in English only.

Recommended papers for printing only

Certain papers are supported only when you start the print job from your computer. The
following list provides information about these papers.

If you want the best print quality, HP recommends using HP papers. Using paper that is
too thin or too thick, paper that has a slick texture, or paper that stretches easily can cause
paper jams. Using paper that has a heavy texture or does not accept ink can cause printed
images to smear, bleed, or not fill in completely.

Depending on your country/region, some of these papers might not be available.

HP Iron-On Transfers

HP Iron-On Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.

HP Brochure & Flyer Paper

HP Brochure & Flyer Paper (Gloss or Matte) is glossy-coated or matte-coated on both
sides for two-sided use. They are the perfect choice for near-photographic reproductions
and business graphics for report covers, special presentations, brochures, mailers, and
calendars.

HP Premium Presentation Paper
HP Premium Presentation Paper gives your presentation a quality look and feel.
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To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.

Bf NOTE: Atthis time, some portions of the HP Web site are available in English only.

Papers to avoid

Using paper that is too thin or too thick, paper that has a slick texture, or paper that
stretches easily can cause paper jams. Using paper that has a heavy texture or does not
accept ink can cause printed images to smear, bleed, or not fill in completely.

Choose papers for printing and copying 23
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Bf NOTE: For a complete list of supported media sizes, see the printer software.

Papers to avoid for all print and copy jobs
* Any size paper other than those listed in the printer software.

« Paper with cutouts or perforations (unless specifically designed for use with HP inkjet
devices).

« Highly textured stock, such as linen. It might not print evenly, and the ink can bleed
into these papers.

«  Extremely smooth, shiny, or coated papers not specifically designed for the HP All-
in-One. They can jam the HP All-in-One or repel the ink.

* Multi-part forms, such as duplicate and triplicate forms. They can wrinkle or get stuck,
and the ink is more likely to smear.

+ Envelopes with clasps or windows. They can get stuck in the rollers and cause paper
jams.

+ Banner paper.

Additional papers to avoid when copying
*  Envelopes.

»  Transparency film other than HP Premium Inkjet Transparency Film or HP Premium
Plus Inkjet Transparency Film.

¢ Iron-On Transfers.
Greeting card paper.

Load paper

This section describes the procedure for loading different types and sizes of paper into
the HP All-in-One for your copies or printouts.

{} TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
a resealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the HP All-in-One.

This section contains the following topics:

Load full-size paper
 Load 10 x 15 cm (4 x 6 inch) photo paper
* Load index cards

* Load envelopes
* Load other types of paper
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Load full-size paper
You can load many types of letter or A4 paper into the input tray of the HP All-in-One.
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To load full-size paper
1. Flip the tray extender up toward you.

B NOTE: When you use legal-size paper, leave the tray extender closed.

2. Slide the paper-width guide to its outermost position.

3. Tap a stack of paper on a flat surface to align the edges, and then check the paper
for the following:

* Make sure it is free of rips, dust, wrinkles, and curled or bent edges.
* Make sure all the paper in the stack are the same size and type.
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4. Insert the stack of paper into the input tray with the short edge forward. Ensure that
the side you want to print on faces down. Slide the stack of paper toward the product
until it stops.

/\ CAUTION: Make sure that the product is idle and silent when you load paper
into the input tray. If the product is servicing the print cartridges or otherwise
engaged in a task, you could push the paper too far forward, causing the product
to eject blank pages.

Q TIP: If you are using letterhead, insert the top of the page first with the side you
want to print on facing down. For more help on loading full-size paper and
letterhead, refer to the diagram engraved in the base of the input tray.

5. Slide the paper-width guide inward until it stops at the edge of the paper.
Do not overload the input tray; make sure the stack of paper fits within the input tray
and is no higher than the top of the paper-width guide.

-
(o]
D
o
(=]
=

&
3
o}
(7]
D
3
o
o
D
o

©
QD

T
@
=

Load 10 x 15 cm (4 x 6 inch) photo paper

You can load 10 x 15 cm (4 x 6 inch) photo paper into the input tray of the HP All-in-One.
For the best results, use 10 x 15 cm (4 x 6 inch) HP Premium Plus Photo Paper or HP
Premium Photo Paper with tab.

B NOTE: For borderless printing, the HP All-in-One only supports 10 x 15 cm (4 x 6
inch) photo paper with a tear-off tab. You can automatically adjust the settings in the
Properties dialog box to print a borderless 10 x 15 cm (4 x 6 inch) photo on
HP Premium Plus Photo Paper. Click the Printing Shortcuts tab, and then, in the
Printing Shortcuts list, select Photo printing-borderless.
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Q TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
aresealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the HP All-in-One.

To load photo paper in the input tray

1. Remove all paper from the input tray.

2. Insert the stack of photo paper into the far-right side of the input tray with the print
side or glossy side down and short edge forward. Slide the stack of photo paper
toward the product until it stops.

If you are using photo paper that has a tear-off tab, verify that the tab is pointing away
from the product.

{} TIP: For more help on loading small-size photo paper, refer to the guides
engraved in the base of the input tray for loading photo paper.

3. Slide the paper-width guide inward until it stops at the edge of the paper.
Do not overload the input tray; make sure the stack of paper fits within the input tray
and is no higher than the top of the paper-width guide.

For best results, set the paper type before copying or printing.

Related topics

* Recommended papers for printing and copying
* Change the print settings for the current job

+ Set the copy paper type
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Load index cards

You can load index cards into the input tray of the HP All-in-One to print notes, recipes,
and other text.

For best results, set the paper type before copying or printing.

BY NOTE: The HP All-in-One leaves a 1.2 cm (0.5 inch) border on one short edge.
Before printing many cards, print one test card to make sure that the border does not
crop your text.
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To load index cards in the input tray

1. Remove all paper from the input tray.

2. Insert the stack of cards vertically (short edge facing outwards), with the side you
want to print on facing down, into the far-right side of the input tray. Slide the stack of
cards forward until it stops.

3. Slide the paper-width guide inward against the stack of cards until it stops.

Do not overload the input tray; make sure the stack of cards fits within the input tray
and is no higher than the top of the paper-width guide.

For best results, set the paper type before copying or printing.

Related topics

 Load 10 x 15 cm (4 x 6 inch) photo paper

» Change the print settings for the current job
» Set the copy paper type

Load envelopes

You can load one or more envelopes into the input tray of the HP All-in-One. Do not use
shiny or embossed envelopes or envelopes that have clasps or windows.

Bf NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a label
for the return address on envelopes.
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To load envelopes
1. Remove all paper from the input tray.

2. Insertone or more envelopes into the far-right side of the input tray, with the envelope
flaps on the left and facing up. Slide the stack of envelopes forward until it stops.

{} TIP: To avoid paper jams, tuck the flap inside each envelope.

TIP: For more help on loading envelopes, refer to the diagram engraved in the
base of the input tray.

3. Slide the paper-width guide inward against the stack of envelopes until it stops.
Do not overload the input tray; make sure the stack of envelopes fits within the input
tray and is not higher than the top of the paper-width guide.

Load other types of paper

The following papers require extra attention to load them properly.

BY NOTE: Not all paper sizes and paper types are available with all the functions on
the HP All-in-One. Some paper sizes and paper types can only be used if you are
starting a print job from the Print dialog box in a software application. They are not
available for copying. Papers that are only available for printing from a software
application are indicated as such.

HP Premium Inkjet Transparency Film

A Insert the film so that the white transparency strip (with arrows and the HP logo) is on
top and is going into the input tray first.

Bf NOTE: The HP All-in-One cannot automatically detect the paper type. For best
results, set the paper type to transparency film in the software before printing onto
transparency film.
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HP Iron-On Transfers (for printing only)
1. Flatten the transfer sheet completely before using it; do not load curled sheets.

{r TIP: To prevent curling, keep transfer sheets sealed in the original package until
you are ready to use them.

2. Locate the blue stripe on the nonprinting side of the transfer paper and then manually
feed one sheet at a time into the input tray with the blue stripe facing up.
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Related topics

 Load 10 x 15 cm (4 x 6 inch) photo paper
» Set the paper type for printing

» Set the copy paper type
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7  Print from your computer

The HP All-in-One can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.

This section contains the following topics:

Print from a software application

Make the HP All-in-One the default printer
Change the print settings for the current job
Change the default print settings

Printing shortcuts
Perform special print jobs

Stop a print job
Resume a print job

Print from a software application

Most print settings are automatically handled by the software application. You need to
change the settings manually only when you change print quality, print on specific types
of paper or transparency film, or use special features.

To print from a software application

1.

2.
3.
4

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.

Make sure the product is the selected printer.

If you need to change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

B NOTE: When printing a photo, you must select options for the specific photo
paper and photo enhancement.

Select the appropriate options for your print job by using the features available in the
Advanced, Printing Shortcuts, Features, and Color tabs.

{} TIP: You can easily select the appropriate options for your print job by choosing
one of the predefined print tasks on the Printing Shortcuts tab. Click a type of
print task in the Printing Shortcuts list. The default settings for that type of print
task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing
shortcut. To save a custom printing shortcut, select the shortcut and click Save
As. To delete a shortcut, select the shortcut and click Delete.

Click OK to close the Properties dialog box.
Click Print or OK to begin printing.
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Make the HP All-in-One the default printer

You can set the HP All-in-One as the default printer to use from all software applications.
This means that the HP All-in-One is automatically selected in the printer list when you
select Print from the File menu in a software application. The default printer is
automatically selected when you click the Print button in the toolbar of most software
applications. For more information, see the Windows Help.

Change the print settings for the current job

You can customize the print settings of the HP All-in-One to handle nearly any print task.
This section contains the following topics:

» Set the paper size

» Set the paper type for printing

* View the print resolution
Change the print speed or quality
Change the page orientation

* Scale the document size

* Preview your print job

Set the paper size

The paper size setting helps the HP All-in-One determine the printable area on the page.
Some of the paper size choices have a borderless equivalent, which allows you to print
to the top, bottom, and side edges of the paper.

Usually, you set the paper size in the software application you used to create your
document or project. However, if you are using custom-size paper, or if you cannot set
the paper size from your software application, you can change the paper size in the
Properties dialog box before printing.

To set the paper size

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
6. In the Resizing Options area, click the appropriate paper size from the Size list.

The following table lists the suggested paper size settings for the different types of
paper you can load in the input tray. Make sure to look at the long list of choices in

o
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the Size list to see if a defined paper size already exists for the type of paper you are
using.

Paper type Suggested paper size settings

Copier, multi-purpose, or Letter or A4

plain papers

Envelopes Appropriate listed envelope size

Greeting-card papers Letter or A4

Index cards Appropriate listed card size (if listed sizes are not appropriate,
you can specify a custom paper size)

Inkjet papers Letter or A4

Iron-on T-shirt transfers Letter or A4

Labels Letter or A4

Legal Legal

Letterhead Letter or A4

Panorama photo paper Appropriate listed panorama size (if listed sizes are not
appropriate, you can specify a custom paper size)

Photo papers 10 x 15 cm (4 x 6 inch), letter, A4, or an appropriate listed size

Transparency films Letter or A4

Custom-size papers Custom paper size

Set the paper type for printing

If you print on special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality, you can set the paper type manually.

To set the paper type for printing

1.

2.
3.
4

o o

View the print resolution

The printer software displays the print resolution in dots per inch (dpi). The dpi varies
according to the paper type and print quality that you select in the printer software.

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
In the Basic Options area, from the Paper Type drop-down list, select More.
Select the type of paper that you have loaded, and then click OK.
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To view the print resolution

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. In the Print Quality drop-down list, select the appropriate print quality setting for your
project.

7. In the Paper Type drop-down list, select the type of paper that you have loaded.
8. Click the Resolution button to view the print resolution dpi.

<

Change the print speed or quality

The HP All-in-One automatically chooses a print quality and speed setting depending on
the paper type setting you select. You can also change the print quality setting to
customize the speed and quality of the print process.

To select a print speed or quality

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.

3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

6. In the Print Quality drop-down list, select the appropriate quality setting for your
project.

<,

Bf NOTE: To view the maximum dpi that the product will print, click Resolution.

7. Inthe Paper Type drop-down list, select the type of paper that you have loaded.

Change the page orientation

The page orientation setting allows you to print your document vertically or horizontally
on the page.

Usually, you set the page orientation in the software application you used to create your
document or project. However, if you are using custom-size or special HP paper, or if you
cannot set the page orientation from your software application, you can change the page
orientation in the Properties dialog box before printing.

To change the page orientation

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
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Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Basic Options area, do one of the following:

» Click Portrait to print the document vertically on the page.

» Click Landscape to print the document horizontally on the page.

Scale the document size

The HP All-in-One allows you to print the document at a different size than the original.

To scale the document size

1.

2.
3.
4

o

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.

Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Resizing options area, click Scale to paper size, and then click the
appropriate paper size from the drop-down list.

Preview your print job

You can preview your print job before sending it to the HP All-in-One. This helps to prevent
wasting paper and ink on projects that do not print as expected.

To preview your print job

1.

2.
3.
4

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Select the print settings appropriate for your project on each of the tabs in the dialog
box.

Click the Features tab.

Select the Show Preview Before Printing check box.
Click OK, and then click Print or OK in the Print dialog box.
Your print job displays in the preview window.

In the HP preview window, do one of the following:

« To print, click Start Printing.

* To cancel, click Cancel Printing.
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Change the default print settings

If there are settings that you frequently use for printing, you might want to make them the
default print settings so they are already set when you open the Print dialog box from
within your software application.

To change the default print settings

1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Settings.

2. Make changes to the print settings, and click OK.

Printing shortcuts

Use printing shortcuts to print with print settings that you use often. The printer software
has several specially designed printing shortcuts that are available in the Printing
Shortcuts list.

B NOTE: When you select a printing shortcut the appropriate printing options are
automatically displayed. You can leave them as is or change them. You can also
create a shortcut. For more information, see Create printing shortcuts.

Use the Printing Shortcuts tab for the following print tasks:

General Everyday Printing: Print documents quickly.

Photo Printing—Borderless: Print to the top, bottom, and side edges of 10 x 15 cm
(4 x 6 inch) HP Premium Plus Photo Papers with a tear-off tab.

Photo Printing—With White Borders: Print a photo with a white border around the
edges.
Fast/Economical printing: Produce draft-quality printouts quickly.
Presentation printing: Print high-quality documents, including letters and
transparencies.
Two-sided (Duplex) Printing: Print two-sided pages with the HP All-in-One
manually.

This section contains the following topics:

Create printing shortcuts
Delete printing shortcuts

Related topics
» Print a borderless image
Print a photo on photo paper
» Print on transparencies
» Print on both sides of the page

Create printing shortcuts

In addition to the printing shortcuts that are available in the Printing Shortcuts list, you
can create your own printing shortcuts.

If you frequently print on transparency film, for example, you can create a printing shortcut
by selecting the Presentation Printing shortcut, changing the paper type to HP Premium
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Inkjet Transparency Film, and then saving the modified shortcut under a new name; for
example, Transparency Presentations. After creating the printing shortcut, simply
select it when printing on transparency film rather than changing the print settings each
time.

To create a printing shortcut

1.
2.
3.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.
Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Printing Shortcuts tab.

In the Printing Shortcuts list, click a printing shortcut.

The print settings for the selected printing shortcut are displayed.

Change the print settings to those you want in the new printing shortcut.

Click Save as and type a name for the new printing shortcut, and then click Save.
The printing shortcut is added to the list.

Delete printing shortcuts

You might want to delete printing shortcuts that you no longer use.

To delete a printing shortcut

1.
2.
3.

o

Perform

In addition to supporting standard print jobs, the HP All-in-One can perform special jobs
such as printing borderless images, iron-on transfers, and posters.

This section contains the following topics:

On the File menu in your software application, click Print.
Make sure the product is the selected printer.
Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Printing Shortcuts tab.
In the Printing Shortcuts list, click the printing shortcut that you want to delete.

Click Delete.
The printing shortcut is removed from the list.

NOTE: Only the shortcuts that you have created can be deleted. The original HP
shortcuts cannot be deleted.

special print jobs

Print a borderless image

Print a photo on photo paper
Print using Maximum dpi

Print on both sides of the page
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Print a multiple-page document as a booklet

Print multiple pages on a single sheet

Print a multiple-page document in reverse order
Reverse an image for iron-on transfers

Print on transparencies

Print a group of addresses on labels or envelopes
Print a poster

Print a Web page

Print a borderless image

38

Borderless printing lets you print to the top, bottom, and side edges of 10 x 15 cm (4 x 6
inch) HP Premium Plus Photo Papers with a tear-off tab. When you remove the tear-off
tab, the printed image is borderless and extends to the edges of the paper.

v TIP: You can automatically adjust the settings in the Properties dialog box to print

a borderless 10 x 15 cm (4 x 6 inch) photo on HP Premium Plus Photo Paper. Click
the Printing Shortcuts tab, and then, in the Printing Shortcuts list, select Photo
printing-borderless. You can also set the options manually as described in the
following procedure.

To print a borderless image

1.
2,

P

Remove all paper from the input tray.

Place the photo paper, with the print side down and the short edge forward, on the
right side of the input tray. Verify that the tear-off tab is pointing away from the product.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.
Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
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6. Click the Features tab.
7. In the Size list, click the size of photo paper loaded in the input tray.

If a borderless image can be printed on the specified size, the Borderless printing
check box is enabled.

8. In the Paper Type drop-down list, click More, and then select the appropriate paper
type.

B NOTE: You cannot print a borderless image if the paper type is set to Plain
paper or to a type of paper other than a photo paper.

9. Select the Borderless printing check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the product software
displays an alert and allows you to select a different type or size.

10. Click OK, and then click Print or OK in the Print dialog box.

Bf NOTE: Do notleave unused photo paper in the input tray. The paper might start
to curl, which could reduce the quality of your printout. Photo paper should be flat
before printing.

Related topics
Load 10 x 15 cm (4 x 6 inch) photo paper

Print a photo on photo paper

To achieve the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing along with genuine HP ink. HP papers
and HP ink are specifically designed to work well together to provide high-quality output.

For photo printing, HP recommends that you use HP Premium Plus Photo Papers with
the HP All-in-One.

To print a photo on photo paper
1. Remove all paper from the input tray, and then load the photo paper print side down.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
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6. In the Basic Options area, select the appropriate photo paper type from the Paper
Type drop-down list.

7. In the Resizing Options area, click the appropriate paper size from the Size list.
If the paper size and paper type are not compatible, the product software displays an
alert and allows you to select a different type or size.

8. In the Basic Options area, select a high print quality, such as Best, from the Print
Quality drop-down list.

fﬁ’ NOTE: For maximum dpi resolution, go to the Advanced tab, and then select
Enabled from the Maximum dpi drop-down list. For more information, see Print
using Maximum dpi.

9. Inthe HP Real Life Technologies area, click the Photo fix drop-down list and select
from the following options:

» Off: applies no HP Real Life Technologies to the image.
+ Basic: enhances low-resolution images; moderately adjusts image sharpness.

* Full: automatically adjusts brightness, contrast, and sharpness; enhances low-
resolution images; automatically removes red-eye coloring in the photo.

4} TIP: You can remove red-eye coloring in the photo when using the Off or
Basic mode by selecting the Remove red eye check box.

10. Click OK to return to the Properties dialog box.

11. (Optional) If you want to print the photo in black and white, click the Color tab and
select the Print in grayscale check box. From the drop-down list, select one of the
following options:

* High Quality: uses all the available colors to print your photo in grayscale. This
creates smooth and natural shades of gray.

» Black Ink Only: uses black ink to print your photo in grayscale. The gray shading
is created by varying patterns of black dots, which might result in a grainy image.

12. Click OK, and then click Print or OK in the Print dialog box.

Bf NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat before
printing.

Print using Maximum dpi
Use Maximum dpi mode to print high-quality, sharp images.

To get the most benefit from Maximum dpi mode, use it to print high-quality images such
as digital photographs. When you select the Maximum dpi setting, the printer software
displays the optimized dots per inch (dpi) that the HP All-in-One will print.

Printing in Maximum dpi takes longer than printing with other settings and requires a
large amount of disk space.

E¥ NOTE: If a photo print cartridge is also installed, the print quality is enhanced. A
photo print cartridge can be purchased separately if it is not included with the HP All-
in-One. Photo print cartridges are not supported on all models of the product.
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To print in Maximum dpi mode

1.

PN

@O No o

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.

In the Printer Features area, select Enabled from the Maximum dpi drop-down list.
Click the Features tab.

In the Paper Type drop-down list, click More, and then select the appropriate paper
type.

In the Print Quality drop-down list, click Maximum dpi.

Bf NOTE: To view the maximum dpi that the product will print, click Resolution.

10. Select any other print settings that you want, and then click OK.

Related topics
Work with print cartridges

Print on both sides of the page

You can print two-sided pages with the HP All-in-One manually. When printing two-sided
pages, make sure to use paper that is thick enough so that images do not show through
to the other side.

To print on both sides of the page

1.

2.
3.
4

o

Load paper into the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Paper saving options area, select Manual from the Two-sided printing drop-
down list.
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7. For binding, do one of the following:
« Forbinding on the top like a notebook or calendar, select the Flip Pages Up check
box.
This causes the odd and even pages of your document to print opposite of each
other top-to-bottom. This ensures that the top of the page is always at the top of
the sheet when you flip the pages up in your bound document.

* For binding on the side like a book or magazine, click to clear the Flip Pages
Up check box.

This causes the odd and even pages of your document to print opposite of each
other left-to-right. This ensures that the top of the page is always at the top of the
sheet when you turn the pages in your bound document.

il
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8. Click OK, and then click Print or OK in the Print dialog box.
The product begins printing. Wait until all the odd-numbered pages are printed before
removing any of the printed pages from the output tray.
A dialog box displays instructions on the screen when itis time to process the second
side of your job.

9. Click Continue when done.

Print a multiple-page document as a booklet

The HP All-in-One allows you to print your document as a small booklet, which you can
fold and then staple together.

For best results, design your document to fit on a multiple of four pages, such as an 8,
12, or 16-page program for a child's school play or for a wedding.

1149 47
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To print a multiple-page document as a booklet

1.

w

10.

1.

Load paper into the input tray.

The paper should be thick enough so that the images do not show through to the
other side.

On the File menu in your software application, click Print.

Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Paper saving options area, select Manual from the Two-sided printing drop-
down list.

Select the binding edge from the Booklet layout is list, as appropriate for your
language.

» If your language reads left-to-right, click Left edge binding.

« If your language reads right-to-left, click Right edge binding.

The Pages per sheet box is automatically set to two pages per sheet.

Click OK, and then click Print or OK in the Print dialog box.

The product begins printing.

A dialog box displays instructions on the screen when it is time to process the second
side of your job. Do not click Continue in the dialog box until you have reloaded the
paper as instructed in the following steps.

Wait until the product has stopped printing for several seconds before removing any
of the printed pages from the output tray.

If you remove the pages while the document is still printing, the pages might get out
of order.

Follow the instructions that appear on your screen for reloading the paper to print on
the second side, and then click Continue.

When the entire document has finished printing, fold the stack of paper in half, so that
the first page is on top, then staple the document along the crease.

ﬁ} TIP: For best results, use a saddle stapler, or a heavy-duty stapler with a long
reach to staple the booklet.
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Figure 7-1 Left-edge binding for left-to-right languages
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Figure 7-2 Right-edge binding for right-to-left languages
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Print multiple pages on a single sheet
You can print up to 16 pages on a single sheet of paper.
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To print multiple pages on a single sheet

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Pages per sheet list, click 2, 4, 6, 9, or 16.

7. Ifyou want a border to appear around each page image printed on the sheet of paper,
select the Print page borders check box.

8. In the Page order list, click an appropriate page order option.
The sample output graphic is numbered to show how the pages will be ordered if you
select each option.

9. Click OK, and then click Print or OK in the Print dialog box.

oo
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Print a multiple-page document in reverse order

Because of the way the paper feeds through the HP All-in-One, the first page that prints
is print side up at the bottom of the stack. Usually this means you need to put the printed
pages in the correct order.

=

A better way is to print the document in reverse order so that the pages are stacked

correctly.

{} TIP: Set this option as a default setting so you do not have to remember to set it
every time you print a multiple-page document.
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o print a multiple-page document in reverse order

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.
In the Layout Options area, select Front to Back in the Page Order option.

PoODdN-=
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BY NOTE: If you set your document to print on both sides of the page, the Front to
Back option is not available. Your document will automatically print in the correct
order.

7. Click OK, and then click Print or OK in the Print dialog box.

Bf NOTE: When you are printing multiple copies, each set is printed completely
before the next set is printed.
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Reverse an image for iron-on transfers

This feature reverses an image so you can use it for iron-on transfers. This feature is also
useful for transparencies when you want to make notations on the back of the
transparency without scratching the original.

-

To reverse an image for iron-on transfers

1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.

In the Paper Type drop-down list, click More, and then select HP Iron-on Transfer
from the list.

If the selected size is not what you want, click an appropriate size in the Size list.
Click the Advanced tab.

In the Printer Features area, select On from the Mirror Image drop-down list.
Click OK, and then click Print or OK in the Print dialog box.

a s
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Bf NOTE: To preventjams, manually feed the iron-on transfer sheets into the input
tray one sheet at a time.

Print on transparencies

For the best results, HP recommends you use HP transparency products with the HP All-
in-One.

To print on transparencies

1. Load the transparency into the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
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6.

In the Basic Options area, from the Paper Type drop-down list, select More. Then
select the appropriate paper type.

X TIP: If you want to make notations on the back of the transparencies and erase
them later without scratching the original, click the Advanced tab, and select the
Mirror Image check box.

In the Resizing Options area, from the Size drop-down list, select More. Then, select
an appropriate size.

Click OK, and then click Print or OK in the Print dialog box.

BY NOTE: The product automatically waits for transparencies to dry before
releasing them. Ink dries slower on film than on plain paper. Make sure you allow
enough time for the ink to dry before handling the transparency.

Print a group of addresses on labels or envelopes

With the HP All-in-One, you can print on a single envelope, a group of envelopes, or label
sheets designed for inkjet printers.

To print a group of addresses on labels or envelopes

1.
2,

Print a test page on plain paper first.

Place the test page on top of the label sheet or envelope, and hold both up to the
light. Check the spacing for each block of text. Make adjustments as needed.

Load the labels or envelopes into the input tray.

/\ CAUTION: Do not use envelopes with clasps or windows. They can get stuck in
the rollers and cause paper jams.

If you are printing on envelopes, do the following:

a. Display the print settings, and click the Features tab.

b. Inthe Resizing Options area, click the appropriate envelope size in the Size list.
Click OK, and then click Print or OK in the Print dialog box.

Related topics
Load envelopes
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Print a poster

You can create a poster by printing a document on multiple pages. The HP All-in-One
prints dotted lines on some pages to indicate where to trim the pages before taping them
together.

To print a poster

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,

Options, Printer Setup, Printer, or Preferences.

Click the Advanced tab.

6. Expand Document Options, and then expand Printer Features.

7. In the Poster Printing drop-down list, click either 2x2 (4 sheets), 3x3 (9 sheets),
4x4 (16 sheets), or 5x5 (25 sheets).
This selection tells the product to enlarge your document so that it fits on 4, 9, 16, or
25 pages.
If your originals are of multiple pages, each of those pages will be printed on 4, 9, 16,
or 25 pages. For example, if you have a one-page original and you select 3x3, you
will get 9 pages; if you select 3x3 for a two-page original, 18 pages will print.

8. Click OK, and then click Print or OK in the Print dialog box.

9. After the poster has printed, trim the edges of the sheets and tape the sheets together.

o

Print a Web page
You can print a Web page from your Web browser on the HP All-in-One.

If you use Internet Explorer 6.0 or higher for Web browsing, you can use HP Smart Web
Printing to ensure simple, predictable web printing with control over what you want and
how you want it printed. You can access HP Smart Web Printing from the toolbar in
Internet Explorer. For more information about HP Smart Web Printing, see the help file
provided with it.
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To print a Web page
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your Web browser, click Print.

X TIP: For bestresults, select HP Smart Web Printing on the File menu. A check
mark appears when it is selected.

The Print dialog box appears.

3. Make sure the product is the selected printer.

4. If your Web browser supports it, select the items on the Web page that you want to
include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as As
laid out on screen, Only the selected frame, and Print all linked documents.

5. Click Print or OK to print the Web page.

ﬂ} TIP: To print Web pages correctly, you might need to set your print orientation to
Landscape.

Stop a print job

Although you can stop a print job from either the HP All-in-One or the computer, HP
recommends you stop it from the HP All-in-One for best results.

To stop a print job from the product
A Press Cancel. If the print job does not stop, press Cancel again.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows Vista users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers.

3. Double-click the product icon.

% TIP: You can also double-click the printer icon in the Windows taskbar.

s

Select the print job you want to cancel.

On the Document menu, click Cancel Printing or Cancel, or press the Delete key
on your keyboard.

It can take a few moments for the print job to be cancelled.

ol

To stop a print job from the computer (Windows XP users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Open the Printers and Faxes control panel.

3. Double-click the product icon.

% TIP: You can also double-click the printer icon in the Windows taskbar.
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4. Select the print job you want to cancel.

5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key
on your keyboard.
It can take a few moments for the print job to be cancelled.

To stop a print job from the computer (Windows 2000 users)
1. On the Windows taskbar, click Start, point to Settings, and then click Printers.
2. Double-click the product icon.

X¥ TIP: You can also double-click the printer icon in the Windows taskbar.

3. Select the print job you want to cancel.
4. On the Document menu, click Cancel or press the Delete key on your keyboard.
It can take a few moments for the print job to be cancelled.

Related topics
Control panel buttons

Resume a print job

If an error occurs while printing, you may need to resume the job from the HP All-in-One
or the computer after you address the error.

To resume a print job from the control panel
A On the control panel, press any button.

To resume a print job from the computer (Windows Vista users)
1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers.

3. Double-click the product icon.

{} TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to resume.
5. On the Document menu, click Resume Printing or Resume.
It can take a few moments to resume the print job.

To resume a print job from the computer (Windows XP users)

1. On the Windows taskbar, click Start, and then click Control Panel.
2. Open the Printers and Faxes control panel.

3. Double-click the product icon.

{} TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to resume.
5. On the Document menu, click Resume Printing or Resume.
It can take a few moments to resume the print job.
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To resume a print job from the computer (Windows 2000 users)
1. On the Windows taskbar, click Start, point to Settings, and then click Printers.
2. Double-click the product icon.

X TIP: You can also double-click the printer icon in the Windows taskbar.

3. Select the print job you want to resume.
4. On the Document menu, click Resume.
It can take a few moments to resume the print job.

Related topics
Control panel buttons
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8 Use the copy features

The HP All-in-One allows you to produce high-quality color and black-and-white copies
on a variety of paper types. You can enlarge or reduce the size of an original to fit a
specific paper size, adjust the copy quality, and make high-quality copies of photos,
including borderless copies.

BY NOTE: If you are using the product with a Windows 2000 computer, some features

This section contains the following topics:

may not be available. For more information, see Notice to Windows 2000 users.
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Make a copy
Set the copy paper type

Change copy speed

Make multiple copies of the same original

Copy a two-page black-and-white document

Make a 10 x 15 cm (4 x 6 inch) borderless copy of a photo

« Stop copying
Make a copy

You can make quality copies from the control panel.

To make a copy from the control panel

1.
2,

Make sure you have paper loaded in the input tray.

Place your original with the side you want to copy or scan face down on the left front
corner of the glass.

{r TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.

Press the Paper Type button to set the paper type.
Press Start Copy Black or Start Copy Color.

Related topics
Control panel buttons

Set the copy paper type

You can set the paper type for copying to either Plain or Photo.

To set the paper type for copies

1.
2.

Make sure you have paper loaded in the input tray.

Place your original with the side you want to copy or scan face down on the left front
corner of the glass.
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3. Press the Paper Type button to set the paper type.
Copies made on photo paper are automatically made using Best quality. When Photo
Paper is selected, the HP All-in-One enlarges or shrinks the original to fit within the
copy margin of the detected paper size.
Copies made on plain paper are automatically made using Normal quality. When the
Plain Paper is selected, the HP All-in-One makes an exact copy of the original placed
on the scanner glass.

Bf NOTE: Ensure that the scanner glass is clean for the copy function to work
properly.

4. Press Start Copy Black or Start Copy Color.
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Refer to the following table to determine which paper type setting to choose based on the
paper loaded in the input tray.

Paper type Control panel setting
Copier paper or letterhead Plain
HP Bright White Paper Plain
HP Premium Plus Photo Paper, Glossy Photo
HP Premium Plus Photo Paper, Matte Photo
HP Premium Plus 4 x 6 inch Photo Paper Photo
HP Photo Paper Photo
HP Everyday Photo Paper Photo
HP Everyday Photo Paper, Semi Gloss Photo
Other photo paper Photo
HP Premium Paper Plain
HP All-in-One Paper Plain
HP Printing Paper Plain
Other inkjet paper Plain
Legal Plain

Related topics
Control panel buttons

Change copy speed
Copies made from the control panel on regular, plain paper automatically use Normal
quality.

You can make a Fast copy using the instructions below. Fast copies faster with
comparable quality text, but the graphics quality might be lower. Fast copies use less ink
and extend the life of your print cartridges.
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Br NOTE: Fast or Normal are not available when the paper type is set to Photo.

To make a Fast copy
1. Make sure you have paper loaded in the input tray.

2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.

{r TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.

3. Press the Paper Type button to set the paper type.

4. Press and hold down the Scan button, and then press either Start Copy Black or
Start Copy Color.
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Related topics
Control panel buttons
Set the copy paper type

Make multiple copies of the same original

You can set the number of copies from the control panel or from the software that you
installed with the HP All-in-One.

To make multiple copies of an original from the control panel
1. Make sure you have paper loaded in the input tray.

2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.

{} TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.

3. Press the Paper Type button to set the paper type.

4. Press the Start Copy Black or Start Copy Color button to increase the number of
copies up to a maximum of 9 (varies by model). The product starts the copy job after
the last button press.

{} TIP: Use the software that you installed with the product to set the number of
copies higher than 9.

In this example, the product makes six copies of the original 10 x 15 cm (4 x 6 inch)
photo.
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Chapter 8

Related topics
Control panel buttons

Copy a two-page black-and-white document

You can use the HP All-in-One to copy a single- or multiple-page document in color or
black and white. In this example, the HP All-in-One is used to copy a two-page black-
and-white original.

To copy a two-page document from the control panel

1.
2.

Make sure you have paper loaded in the input tray.

Place your original with the side you want to copy or scan face down on the left front
corner of the glass.

Press the Paper Type button to set the paper type.
Press Start Copy Black.

Wait until the product has finished printing the first page. Remove the first page from
the glass and load the second page.

Press Start Copy Black.

Related topics
Control panel buttons

Make a 10 x 15 cm (4 x 6 inch) borderless copy of a photo

To make a borderless copy of a photo, use the 10 x 15 cm (4 x 6 inch) HP Premium Plus
Photo Paper with a tear-off tab. When you remove the tear-off tab, the output is a
borderless copy of the image that extends to the edges of the paper.
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To make a borderless copy of a photo from the control panel

1. Load 10 x 15 cm (4 x 6 inch) tabbed photo paper in the input tray. Verify that the tab
is pointing away from the product.
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B NOTE: To make a borderless copy, you must use tabbed photo paper.

2. Load your original print side down on the left front corner of the glass.
3. Press Paper Type to select the Photo paper type.

B NOTE: When the Photo paper type is selected, the HP All-in-One defaults to
making a borderless copy with a 10 x 15 cm (4 x 6 inch) original.

4. Press Start Copy Color.
Remove the tab to make the copy completely borderless.

Related topics
Control panel buttons

Stop copying

To stop copying
A Press Cancel on the control panel.
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Related topics
Control panel buttons
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9 Use the scan features

Scanning is the process of converting text and pictures into an electronic format for your
computer. You can scan almost anything (photos, magazine articles and text documents)
on the HP All-in-One.

BY NOTE: When scanning, the HP Photosmart Software enables you to save an image
in the following file formats: BMP, DCX, FPX, GIF, JPG, PCD, PCX, and TIF.

You can use the scanning features of the HP All-in-One to do the following:

« Scan text from an article into your word processor and quote it in a report.

« Printbusiness cards and brochures by scanning a logo and using it in your publishing
software.

« Send photos to friends and relatives by scanning your favorite prints and including
them in e-mail messages.

« Create a photographic inventory of your house or office.
» Archive treasured photos in an electronic scrapbook.

BY NOTE: If you are using the product with a Windows 2000 computer, some features
may not be available. For more information, see Notice to Windows 2000 users.

NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

This section contains the following topics:

* Scan an original
« Edit a scanned preview image

« Edit a scanned image
» Edit a scanned document

» Stop scanning

Scan an original

For original documents or images placed on the glass, you can start a scan from your
computer or from the HP All-in-One. This section explains the second option: how to scan
from the control panel of the HP All-in-One to a computer.

To use the scan features, the HP All-in-One and computer must be connected and turned
on. The HP Photosmart Software must also be installed and running on your computer
prior to scanning. To verify that the HP Photosmart Software is running on a Windows
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computer, look for the HP Digital Imaging Monitor icon in the system tray at the lower
right side of the screen, near the time.

Bf NOTE: Closing the HP Digital Imaging Monitor icon in the Windows system tray
can cause the HP All-in-One to lose some of its scan functionality. If this happens,
you can restore full functionality by restarting your computer or by starting the
HP Photosmart Software.

The HP Photosmart Software that you installed on your computer has many tools that
you can use to edit and print your scanned image. You can improve the overall image
quality by adjusting the brightness, sharpness, color tone, or saturation. You can also
crop, straighten, rotate, or resize the image. When the scanned image looks just the way
you want it, you can open it in another application, send it through e-mail, save it to a file,
or print it.
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To scan to a computer

1. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.

{} TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.

2. Press Scan.
The product scans the original automatically. A preview image of the scan appears
on your computer, where you can edit it. Any edits that you make apply to the current
scan session only.
The HP Photosmart Software has many tools that you can use to edit your scanned
image. You can improve the overall image quality by adjusting the brightness,
sharpness, color tone, or saturation. You can also crop, rotate, or resize the image.

3. Make any edits to the preview image, and then click Accept when you are finished.

Related topics
Control panel buttons

Edit a scanned preview image

You can use the tools in the HP Scanning software to modify a preview image. Any
changes that you make, such as brightness, image type, resolution, and more apply only
to this scan session.

You can make additional changes in the HP Photosmart software after the image is
scanned.

Related topics
Use the HP Photosmart software

Edit a scanned image

You can edit a scanned image, such as a photo or graphic, using the software you
installed with the HP All-in-One. Using this software, you can rotate or crop the image,
as well as adjust the brightness, contrast, and color saturation.

BY NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

Related topics
Use the HP Photosmart software

Edit a scanned document

You can edit a scanned document using your Optical Character Recognition (OCR)
software. Scanning text using OCR software enables you to bring the content of magazine
articles, books, and other printed matter into your favorite word processor and many other
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applications as editable text. Learning to use OCR software correctly is important if you
want to obtain the best results. Do not expect scanned text documents to be letter-perfect
the first time you use your OCR software. Using OCR software is an art that takes time
and practice to master.

B NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

Related topics
Use the HP Photosmart software

Stop scanning

To stop scanning
A Press Cancel on the control panel.

Related topics
Control panel buttons
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10 Maintain the HP All-in-One

The HP All-in-One requires little maintenance. Sometimes you might want to clean the
glass and lid backing to remove surface dust and ensure that your copies and scans
remain clear. You will also need to replace, align, or clean your print cartridges from time
to time. This section provides instructions for keeping the HP All-in-One in top working
condition. Perform these simple maintenance procedures as necessary.

This section contains the following topics:

e Clean the HP All-in-One
* Print a self-test report
e Work with print cartridges

Clean the HP All-in-One

To ensure that your copies and scans remain clear, you might need to clean the glass
and lid backing. You might also want to dust the exterior of the HP All-in-One.

This section contains the following topics:
« Clean the exterior

+ Clean the glass
* Clean the lid backing

Clean the exterior

Use a soft cloth or slightly moistened sponge to wipe dust, smudges, and stains off the
case. The interior of the HP All-in-One does not require cleaning. Keep fluids away from
the control panel and the interior of the HP All-in-One.

/\ CAUTION: To avoid damage to the exterior of the HP All-in-One, do not use alcohol
or alcohol-based cleaning products.

Clean the glass

Fingerprints, smudges, hair, and dust on the main glass surface slow down performance
and affect the accuracy of the copy and scan features.
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To clean the glass
1. Turn off the product, unplug the power cord, and raise the lid.

2. Clean the glass with a soft cloth or sponge slightly moistened with a nonabrasive
glass cleaner.

/\ CAUTION: Do not use abrasives, acetone, benzene, or carbon tetrachloride on
the glass, since they can damage it. Do not place or spray liquid directly on the
glass. The liquid might seep under the glass and damage the product.
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3. Dry the glass with a dry, soft, lint-free cloth to prevent spotting.
4. Plug in the power cord, and then turn on the product.

Clean the lid backing

Minor debris can accumulate on the white document backing located underneath the lid
of the HP All-in-One.

To clean the lid backing
1. Turn off the product, unplug the power cord, and raise the lid.

2. Clean the white document backing with a soft cloth or sponge slightly moistened with
a mild soap and warm water.
Wash the backing gently to loosen debris. Do not scrub the backing.
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3. Dry the backing with a dry, soft, lint-free cloth.

/\ CAUTION: Do not use paper-based wipes, as these might scratch the backing.
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4. If further cleaning is needed, repeat the previous steps using isopropyl! (rubbing)
alcohol, and wipe the backing thoroughly with a damp cloth to remove any residual
alcohol.

/\ CAUTION: Be careful not to spill alcohol on the glass or exterior of the product,
as this might damage it.

5. Plug in the power cord, and then turn on the product.

Print a self-test report

If you are experiencing problems with printing, print a self-test report before you replace
the print cartridges. This report provides useful information on several aspects of your
product, including your print cartridges.

To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Start Copy Color button.

The product prints a self-test report, which might indicate the source of the printing
problem. A sample of the ink test area of the report is shown below.

3. Make sure the test patterns show a complete grid and the thick color lines are

complete.

» If more than a few lines in a pattern are broken, this might indicate a problem with
the nozzles. You might need to clean the print cartridges.

» If the black line is missing, faded, streaked, or shows lines, this might indicate a
problem with the black or photo print cartridge in the right slot.

« If any of the color lines are missing, faded, streaked, or show lines, this might
indicate a problem with the tri-color print cartridge in the left slot.
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Related topics

» Clean the print cartridges

¢ Replace the print cartridges
*  Control panel buttons

Work with print cartridges

To ensure the best print quality from the product, you will need to perform some simple
maintenance procedures. This section provides guidelines for handling the print
cartridges and instructions for replacing, aligning, and cleaning the print cartridges.

You might also need to check your print cartridges if the Check Print Cartridge light is on.
This might mean that the print cartridges are not installed properly or are missing, the
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Chapter 10

plastic tape has not been removed from the print cartridges, the print cartridges are low
on ink, or the print carriage is blocked.

This section contains the following topics:
» Handle the print cartridges

* Check the estimated ink levels

» Replace the print cartridges

* Use ink-backup mode

» Use a photo print cartridge

« Store the print cartridges

» Align the print cartridges

» Clean the print cartridges

» Clean the print cartridge contacts

* Clean the area around the ink nozzles
* Remove ink from your skin and clothing

Handle the print cartridges

66

Before you replace or clean a print cartridge, you should know the part names and how
to handle the print cartridges.

-

Copper-colored contacts

Plastic tape with pink pull tab (must be removed before installing)

Ink nozzles under tape

Hold the print cartridges by their black plastic sides, with the label on top. Do not touch
the copper-colored contacts or the ink nozzles.
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Br NOTE: Handle the print cartridges carefully. Dropping or jarring cartridges can cause
temporary printing problems, or even permanent damage.

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to
replace a print cartridge. The ink supply level shows an estimate of the amount of ink
remaining in the print cartridges. Actual ink levels may vary.

Q TIP: You can also print a self-test report to see if your print cartridges might need to
be replaced.

Br NOTE: Ifthe print cartridges were used before being installed in the product, or have
been refilled, the estimated ink levels on the Estimated Ink levels tab may be
inaccurate or unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of different
ways, including in the initialization process, which prepares the product and cartridges
for printing, and in print head servicing, which keeps print nozzles clear and ink flowing
smoothly. In addition, some residual ink is left in the cartridge after it is used. For more
information, see www.hp.com/go/inkusage.

To check the ink levels from the HP Photosmart Software

1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

Bf NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.
The estimated ink levels for the print cartridges appear.

Related topics
Print a self-test report

Replace the print cartridges
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When the ink level for the print cartridge is low, a message appears on your computer
screen. You can also check the ink levels by using the software installed with the HP All-
in-One. Follow these instructions when the ink level is low.

B NOTE: Ink level warnings and indicators provide estimates for planning purposes
only. When you receive a low-ink warning message, consider having a replacement
cartridge available to avoid possible printing delays. You do not need to replace the
print cartridges until print quality becomes unacceptable.
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To order print cartridges for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

Choose the right cartridge combination
Choose the best combination of cartridges for your print job:

« Everyday printing: Use a black cartridge along with a tri-color cartridge.
+  Color photos: Use a photo cartridge along with a tri-color cartridge.

BY NOTE: If a photo print cartridge is also installed, the print quality is enhanced. A
photo print cartridge can be purchased separately if it is not included with the
HP All-in-One. Photo print cartridges are not supported on all models of the
product.

To replace the print cartridges

1. Make sure the product is on and you have letter or A4 unused plain white paper loaded
in the input tray.

/\ CAUTION: If the product is turned off when you open the print cartridge door to
access the print cartridges, it will not release the cartridges for changing. You
might damage the product if the print cartridges are not docked safely when you
try to remove them.

2. Open the print cartridge door.
The print carriage should move to the center of the product. If the print carriage does
not move to the center, turn the product off, and then on.
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3. Wait until the print carriage is idle and silent, and then lightly press down on a print
cartridge to release it.
If you are replacing the tri-color print cartridge, remove the print cartridge from the
slot on the left.
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If you are replacing the black or photo print cartridge, remove the print cartridge from
the slot on the right.

1 | Print cartridge slot for the tri-color print cartridge

2 | Print cartridge slot for the black and photo print cartridges

4. Pull the print cartridge toward you out of its slot.

5. Ifyou are removing the black print cartridge in order to install the photo print cartridge,
store the black print cartridge in the print cartridge protector or an airtight plastic
container.

If you are disposing of the print cartridge, recycle the print cartridge. The HP Inkjet
Supplies Recycling Program is available in many countries/regions, and lets you
recycle used print cartridges free of charge. For more information, go to the following
Web site:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/inkjet.html

6. Remove the new print cartridge from its packaging, being careful to touch only the
black plastic. Gently remove the plastic tape using the pink pull tab.
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1 | Copper-colored contacts

2 | Plastic tape with pink pull tab (must be removed before installing)

Ink nozzles under tape

/\ CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.
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7. Slide the new print cartridge at a slight upward angle into the empty slot. Then gently
push on the upper part of the print cartridge forward until it snaps into place.
If you are installing the tri-color print cartridge, slide it into the left slot.
If you are installing a black or photo print cartridge, slide it into the right slot.

9. After the print cartridge alignment sheet prints, load it on the left front corner of the
glass with the top of the page to the left.
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10. Press the Scan button.
The product aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

Related topics
*  Check the estimated ink levels
*  Control panel buttons

Use ink-backup mode

Use the ink-backup mode to operate the HP All-in-One with only one print cartridge. The
ink-backup mode is initiated when a print cartridge is removed from the print cartridge
carriage. During ink-backup mode, the product can only print jobs from the computer.
You cannot initiate a print job from the control panel (such as copying or scanning an
original).

Bf NOTE: When the HP All-in-One operates in ink-backup mode, a message is
displayed on screen. If the message is displayed and two print cartridges are installed
in the product, verify that the protective piece of plastic tape has been removed from
each print cartridge. When plastic tape covers the print cartridge contacts, the product
cannot detect that the print cartridge is installed.

For more information about ink-backup mode, see the following topics:

e Ink-backup mode output
e Exit ink-backup mode

Ink-backup mode output

Printing in ink-backup mode slows the HP All-in-One and affects the quality of printouts.

BY NOTE: HP does notrecommend using the photo print cartridge for ink-backup mode.

Installed print cartridge Result g
Black print cartridge Colors print as grayscale. _$
Tri-color print cartridge Colors print but black is grayed and is not a true black. :
T
Photo print cartridge Colors print as grayscale. e
<
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Exit ink-backup mode

Install two print cartridges in the HP All-in-One to exit ink-backup mode.

For information about installing a print cartridge, see Replace the print carfridges.

Use a photo print cartridge

You can optimize the quality of the color photos you print and copy with the HP All-in-
One by purchasing a photo print cartridge. Remove the black print cartridge and insert
the photo print cartridge in its place. With the tri-color print cartridge and photo print
cartridge installed, you have a six-ink system, which provides enhanced quality color
photos.
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When you want to print regular text documents, swap the black print cartridge back in.
Use a print cartridge protector or an airtight plastic container to keep your print cartridge
secure when it is not being used.

Bf NOTE: If a photo print cartridge is also installed, the print quality is enhanced. A
photo print cartridge can be purchased separately if it is not included with the HP All-
in-One. Photo print cartridges are not supported on all models of the product.

Related topics
* Replace the print cartridges
» Control panel buttons

Store the print cartridges

Follow these guidelines to maintain and store HP print cartridges and to ensure consistent
print quality.

» Print cartridge storage and handling

«  Print cartridge protector

Print cartridge storage and handling

Follow these guidelines to help maintain HP print cartridges and ensure consistent print
quality:

* When you remove a print cartridge from the device, store it in an airtight plastic
container to prevent the ink from drying out. If you are storing a photo print cartridge,
you can use a print cartridge protector. For more information, see Print cartridge
protector.

+ Keep all unused print cartridges in their original sealed packages until they are
needed. Store print cartridges at room temperature (15-35 degrees C or 59-95
degrees F).

* Do not remove the plastic tape covering the ink nozzles until you are ready to install
the print cartridge in the device. If the plastic tape has been removed from the print
cartridge, do not attempt to reattach it. Reattaching the tape damages the print
cartridge.

/\ CAUTION: Always turn the HP All-in-One off with the Power button before you
unplug the power cord or turn off a power strip. This allows the device to store the
print cartridges properly. When you store the HP All-in-One, always leave the active
print cartridges inside the device.

Print cartridge protector

In some countries/regions, when you purchase a photo print cartridge (not supported on
all models of the product), you might also receive a print cartridge protector. If a print
cartridge protector is not available, you can use an airtight plastic container to protect
your print cartridge.

The print cartridge protector is designed to keep a print cartridge secure and prevent it
from drying out when it is not being used. Whenever you remove a print cartridge from
the HP All-in-One with the intention of using it again later, store it in the print cartridge
protector. For example, store the black print cartridge in a print cartridge protector if you
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are removing it so you can print high-quality photos with the photo and tri-color print
cartridges.

To insert a print cartridge into the print cartridge protector

A Place the print cartridge into the print cartridge protector at a slight angle and snap it
securely into place.

To remove the print cartridge from the print cartridge protector

A Press down on the top of the print cartridge protector to release the print cartridge,
and then gently remove the print cartridge out of the print cartridge protector.

Align the print cartridges

Aligning the print cartridges ensures high-quality output. The HP All-in-One prompts you
to align and calibrate the print cartridges every time you install a new print cartridge. Make
sure you align the print cartridges when prompted to ensure excellent print quality.
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BY NOTE: If you remove and reinstall the same print cartridge, the HP All-in-One will
not prompt you to align the print cartridges. The HP All-in-One remembers the
alignment values for that print cartridge, so you do not need to realign the print
cartridges.
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To align newly installed print cartridges

1.

Make sure you have letter or A4 unused plain white paper loaded in the input tray.
The HP All-in-One prints a print cartridge alignment sheet.

Bf NOTE: Ifyou have colored paper loaded in the input tray when you align the print
cartridges, the alignment will fail. Load unused plain white paper into the input
tray, and then try the alignment again.

If the alignment fails again, you might have a defective sensor or print cartridge.
Contact HP Support. Go to www.hp.com/support. If prompted, choose your
country/region, and then click Contact HP for information on calling for technical
support.

Load the print cartridge alignment sheet print side down on the left front corner of the
glass with the top of the page to the left.
Press the Scan button.

The HP All-in-One aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

To align the print cartridges from the HP Photosmart Software

1.

Load letter or A4 unused plain white paper into the input tray.

BY NOTE: Ifyou have colored paperloaded in the input tray when you align the print
cartridges, the alignment will fail. Load unused plain white paper into the input
tray, and then try the alignment again.

In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

BY NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

The Printer Toolbox appears.

Click the Device Services tab.

Click Align the Print Cartridges.

The HP All-in-One prints a print cartridge alignment sheet.

Load the print cartridge alignment sheet print side down on the left front corner of the
glass.

Press the Scan button.

The HP All-in-One aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

Related topics
Control panel buttons

Clean the print cartridges

Use this feature when the self-test report shows streaking, white lines through any of the
lines of color or when a color is muddy after installing a print cartridge for the first time.
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Do not clean print cartridges unnecessarily, as this wastes ink and shortens the life of the
ink nozzles.

To clean the print cartridges from the HP Photosmart Software

1.
2,

P

Load letter, A4, or legal unused plain white paper into the input tray.

In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

Bf NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

The Printer Toolbox appears.
Click the Device Services tab.
Click Clean the Print Cartridges.

Follow the prompts until you are satisfied with the quality of the output, and then click
Done.

If print quality still seems poor after you clean the print cartridges, try cleaning the
print cartridge contacts before replacing the affected print cartridge.

Related topics

Clean the print cartridge contacts

/\ CAUTION: Do not clean the print cartridge contacts unless you are having a problem

Clean the print cartridge contacts if you get repeated messages on your computer screen
prompting you to check a print cartridge after you already have cleaned or aligned the
print cartridges, or if the Check Print Cartridge light is blinking.

Before cleaning the print cartridge contacts, remove the print cartridge and verify that
nothing is covering the print cartridge contacts, then reinstall the print cartridge. If you
continue to get messages to check the print cartridges, clean the print cartridge contacts.

Make sure you have the following materials available:

Clean the print cartridge contacts
Replace the print cartridges

with print quality and other measures have not been successful. For more information,
see Print quality troubleshooting.
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Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.

{r TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).

/\ CAUTION: Do not use platen cleaners or alcohol to clean the print cartridge
contacts. These can damage the print cartridge or the product.
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To clean the print cartridge contacts
1. Turn on the product and open the print cartridge door.
The print carriage moves to the center of the product.

2. Wait until the print carriage is idle and silent, and then unplug the power cord from
the back of the product.

3. Lightly press down on the print cartridge to release it, and then pull it toward you out
of the slot.

BY NOTE: Do notremove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the HP All-
in-One for more than 30 minutes.

4. Inspect the print cartridge contacts for ink and debris buildup.

5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any
excess water from it.

6. Hold the print cartridge by its sides.

7. Clean only the copper-colored contacts. Allow the print cartridges to dry for
approximately ten minutes before reinserting.
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Copper-colored contacts

2 | Ink nozzles (do not clean)
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8. Hold the print cartridge with the HP logo on top, and insert the print cartridge back
into the slot. Make sure you push the print cartridge in firmly until it snaps into place.
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9. Repeat if necessary for the other print cartridge.

10. Gently close the print cartridge door and plug the power cord into the back of the
product.

Related topics
* Clean the area around the ink nozzles
* Replace the print cartridges

Clean the area around the ink nozzles

If the HP All-in-One is used in a dusty environment, a small amount of debris might
accumulate inside the device. This debris can include dust, hair, carpet, or clothing fibers.
When debris gets on the print cartridges, it can cause ink streaks and smudges on printed
pages. Ink streaking can be corrected by cleaning around the ink nozzles as described
here.

)

c
Q
=
=
<
o
I

o
<
=
=

©
3
=

©
=

Bf NOTE: Clean the area around the ink nozzles only if you continue to see streaks
and smudges on your printed pages after you have already cleaned the print
cartridges by using the software you installed with the HP All-in-One.
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Make sure you have the following materials available:

»  Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.

{r TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

- Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).

/\ CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.

To clean the area around the ink nozzles
1. Turn on the product and open the print cartridge door.
The print carriage moves to the center of the product.

2. Wait until the print carriage is idle and silent, and then unplug the power cord from
the back of the product.

3. Lightly press down on the print cartridge to release it, and then pull it towards you out
of the slot.

B NOTE: Do notremove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the product
for more than 30 minutes.

4. Place the print cartridge on a piece of paper with the ink nozzles facing up.
5. Lightly moisten a clean foam rubber swab with distilled water.
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6. Clean the face and edges around the ink nozzle area with the swab, as shown below.

1 | Nozzle plate (do not clean)

2 | Face and edges around the ink nozzle area

/\ CAUTION: Do not clean the nozzle plate.

7. Hold the print cartridge with the HP logo on top, and insert the print cartridge back
into the slot. Make sure you push the print cartridge in firmly until it snaps into place.

8. Repeat if necessary for the other print cartridge.

9. Gently close the print cartridge door and plug the power cord into the back of the
product.
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Related topics
Clean the print cartridges
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Remove ink from your skin and clothing
Follow these instructions to remove ink from your skin and clothing:

Surface Remedy

Skin Wash the area with an abrasive soap.

White fabric Wash the fabric in cold water and use chlorine bleach.
Color fabric Wash the fabric in cold water and use sudsy ammonia.

/\ CAUTION: Always use cold water to remove ink from fabric. Warm or hot water can
set the ink into the fabric.
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Shop for ink supplies

For a list of print cartridge numbers, see the printed documentation that came with the
HP All-in-One. You can also use the software that came with the HP All-in-One to find
out the reorder number for all the print cartridges. You can order print cartridges online
from the HP Web site. Additionally, you can contact a local HP reseller to find out the

correct print cartridge reorder numbers for your product and purchase print cartridges.

To order genuine HP supplies for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.

Br NOTE: Ordering print cartridges online is not supported in all countries/regions. If it
is not supported in your country/region, contact a local HP reseller for information
about purchasing print cartridges.

To order print cartridges from your desktop

A Click the Shop for HP Supplies icon on your desktop to connect to HP SureSupply.
You will see a list of original HP printing supplies that are compatible with your device,
as well as options to conveniently purchase the supplies you need (options vary by
country/region).
If you deleted this icon from your desktop, click the Start menu, point to the HP folder,
then click Shop for Supplies.

To order print cartridges through the HP Photosmart Software

1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

E¥ NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.

2. Click the Estimated Ink Levels tab.

3. Click Print Cartridge Ordering Information.
The print cartridge reorder numbers appear.

4. Click Order Online.
HP sends detailed printer information, including model number, serial number, and
ink supply levels, to an authorized online reseller. The supplies you need are
preselected; you can change quantities, add or remove items, and then check out.
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12 Troubleshooting

This section contains the following topics:

* View the Readme file

* Hardware setup troubleshooting

» Software installation troubleshooting
* Paper jams

*  Print cartridge troubleshooting

»  Print quality troubleshooting

*  Print troubleshooting

*  Copy troubleshooting

» Scan troubleshooting

+ Errors
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View the Readme file

You might want to refer to the Readme file for information on system requirements and
possible installation problems.

You can access the Readme file by clicking Start, pointing to Programs or All
Programs, pointing to HP, pointing to Deskjet F2200 All-In-One series, and then
clicking Readme.

You can access the Readme file by double-clicking the icon located in the top-level folder
of the HP All-in-One software CD-ROM.

Hardware setup troubleshooting

This section contains hardware troubleshooting information for the product.

Many issues are caused when the product is connected to the computer using a USB
cable before the HP Photosmart software is installed on the computer. If you connected
the product to your computer before the software installation screen prompts you to do
s0, you must follow these steps:

Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
For more information, see Uninstall and reinstall the software.
3. Restart your computer.
4. Turn off the product, wait one minute, then restart it.
5. Reinstall the HP Photosmart software.

/\ CAUTION: Do not connect the USB cable to the computer until prompted by the
software installation screen.
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Chapter 12

This section contains the following topics:

*  The product will not turn on
* | connected the USB cable, but | am having problems using the HP All-in-One with

my computer
« After setting up the product, it does not print

The product will not turn on

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

* Solution 1: Make sure the power cord is connected

» Solution 2: Press the On button more slowly

Solution 1: Make sure the power cord is connected

Solution:

« Make sure the power cord is firmly connected to both the product and the power
adapter. Plug the power cord into a power outlet, surge protector, or power strip.

1 | Power connection

2 | Power cord and adapter

« If you are using a power strip, make sure the power strip is on. Or, try plugging
the product directly into a power outlet.

« Test the power outlet to make sure it is working. Plug in an appliance that you
know works, and see if the appliance has power. If not, then there might be a
problem with the power outlet.

« If you plugged the product into a switched outlet, make sure the outlet is switched
on. If it is switched to on but still does not work, then there might be a problem
with the power outlet.

Cause: The product was not properly connected to a power supply.
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If this did not solve the issue, try the next solution.

Solution 2: Press the On button more slowly

Solution: The product might not respond if you press the On button too quickly.
Press the On button once. It might take a few minutes for the product to turn on. If
you press the On button again during this time, you might turn the product off.

/\ CAUTION: Ifthe product still does not turn on, it might have a mechanical failure.
Unplug the product from the power outlet.

Contact HP support for service.

Go to: www.hp.com/support. If prompted, choose your country/region, and then
click Contact HP for information on calling for technical support.
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Cause: You pressed the On button too quickly.

I connected the USB cable, but | am having problems using the HP All-in-One with
my computer
Solution: You must first install the software that came with the product before
connecting the USB cable. During installation, do not plug in the USB cable until
prompted by the onscreen instructions.
Once you have installed the software, connecting your computer to the product with
a USB cable is straightforward. Simply plug one end of the USB cable into the back
of your computer and the other into the back of the product. You can connect to any
USB port on the back of your computer.
If you installed the software, uninstall it and then reinstall it, connecting the USB cable
only when prompted.
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For more information on installing the software and connecting the USB cable, see
the Setup Guide that came with the product.

Cause: The USB cable was connected before the software was installed.
Connecting the USB cable before prompted can cause errors.

After setting up the product, it does not print

Solution:

Look at the On button located on the product. If it is not lit, the product is turned
off. Make sure the power cord is firmly connected to the product and plugged into
a power outlet. Press the On button to turn on the product.

Make sure the print cartridges are installed.

Make sure you have paper loaded in the input tray.

Make sure that the product does not have a paper jam.

Check that the print carriage is not jammed.

Open the print cartridge door to access the print carriage area. Remove any
objects that are blocking the print carriage, including any packing materials. Turn
the product off and then turn it on again.

Print a test page to see if the product can print and is communicating with the
computer. For more information, see Print a self-test report.

Make sure that the print queue is not paused. Ifitis, choose the appropriate setting
to resume printing. For more information about accessing the print queue, see
the documentation that came with the operating system installed on your
computer.

Check the USB cable. If you are using an older cable, it might not be working
properly. Try connecting it to another product to see if the USB cable works. If
you experience problems, the USB cable might need to be replaced. Also verify
that the cable does not exceed 3 meters (9.8 feet) in length.

Make sure your computer is USB ready and that you are using a supported
operating system. For more information, see the Readme file.

Check the connection from the product to your computer. Verify that the USB
cable is securely plugged into the USB port on the back of the product. Make sure
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the other end of the USB cable is plugged into a USB port on your computer. After
the cable is connected properly, turn the product off and then on again.
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»  If you are connecting the product through a USB hub, make sure the hub is turned
on. If the hub is on, try connecting directly to your computer.

» Check other printers or scanners. You might need to disconnect older products
from your computer.

»  Try connecting the USB cable to another USB port on your computer. After you
check the connections, try restarting your computer. Turn the product off and then
on again.

»  After you check the connections, try restarting your computer. Turn the product
off and then on again.

» If necessary, remove and then install the software you installed with the product
again. For more information, see Uninstall and reinstall the software.

For more information on setting up the product and connecting it to your computer,
see the Setup Guide that came with the product.

Cause: The product and computer were not communicating with each other.

Software installation troubleshooting

Use this section to solve any problems you might encounter while setting up the

HP Photosmart software.

This section contains the following topics:

*  When linsert the CD-ROM into my computer’'s CD-ROM drive, nothing happens
* The Minimum System Checks screen appears

* A red X appears on the USB connect prompt

* |received a message that an Unknown Error has occurred

» Some of the buttons are missing in the HP Solution Center
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» The registration screen does not appear
* The HP Digital Imaging Monitor does not appear in the system tray
* Uninstall and reinstall the software

When | insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
Solution: If the installation does not run automatically, you can start it manually.

To start the installation from a Windows computer

1. From the Windows Start menu, click Run.

2. In the Run dialog box, enter d:\setup.exe, and then click OK.
If your CD-ROM drive is not assigned to drive letter D, enter the appropriate drive
letter.
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Cause: The installation failed to run automatically.

The Minimum System Checks screen appears

Solution: Click Details to see what the specific problem is, and then correct the
problem before attempting to install the software.

Cause: Yoursystem did not meet the minimum requirements to install the software.

A red X appears on the USB connect prompt

Solution: Verify that the product is set up properly, and then try to re-establish the
connection.

To retry the USB connection
1. Verify that the USB cable is set up properly as follows:

*  Unplug the USB cable and plug it in again or try plugging the USB cable into
a different USB port.

* Do not attach the USB cable to a keyboard.
» Verify that the USB cable is 3 meters (9.8 feet) or less in length.

» If you have several USB devices attached to your computer, you might want
to unplug the other devices during the installation.

2. Unplug the product power cord, and then plug it in again.
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3. Verify that the USB cable and power cord are plugged in.
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4. Click Retry to retry the connection.
5. Continue with the installation and restart the computer when prompted.

Cause: Normally, a green check appears indicating that the plug and play was
successful. A red X indicates that the plug and play failed.

| received a message that an Unknown Error has occurred

Solution: Try to continue with the installation. If that does not work, stop and then
restart the installation, and follow the directions on the screen. If an error occurs, you
might need to uninstall and then reinstall the software. Do not simply delete the
product application files from your computer. Make sure to remove them properly
using the uninstall utility provided when you installed the software that came with the
product.

For more information, see:
Uninstall and reinstall the software

Cause: The source of the error is unknown.

Some of the buttons are missing in the HP Solution Center

Solution: If the appropriate icons and buttons for your product do not appear in the
HP Solution Center, your installation might not be complete, and you might need to

uninstall and then reinstall the software. Do not simply delete the product application
files from your hard drive. Make sure to remove them properly using the uninstall utility
provided in the HP All-in-One program group.

For more information, see:
Uninstall and reinstall the software
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Cause: The installation might not be complete.

The registration screen does not appear

Solution: You can access the registration (Sign up now) screen from the Windows
taskbar by clicking Start, pointing to Programs or All Programs, HP, Deskjet F2200
All-In-One series, and then clicking Product Registration.

Cause: The registration screen did not launch automatically.
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The HP Digital Imaging Monitor does not appear in the system tray

Solution: If the HP Digital Imaging Monitor does not appear in the system tray
(normally located at the lower-right corner of the desktop), start the HP Solution
Center.

If the appropriate icons and buttons for your product do not appear in the HP Solution
Center, your installation might not be complete, and you might need to uninstall and
then reinstall the software. Do not simply delete the product application files from your
hard drive. Make sure to remove them properly using the uninstall utility provided in
the HP All-in-One program group.

For more information, see:

Uninstall and reinstall the software

Cause: The installation might not be complete.

Uninstall and reinstall the software

If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the software installation screen, you might need to uninstall and then
reinstall the software. Do not simply delete the HP All-in-One application files from your
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computer. Make sure to remove them properly using the uninstall utility provided when
you installed the software that came with the HP All-in-One.

To uninstall from a Windows computer

BY NOTE: Use this method if Uninstall is not available in the Windows Start menu (click
Programs or All Programs, HP, Deskjet F2200 All-In-One series, Uninstall).

1. Open the Windows control panel and double-click Add or Remove Programs.

B NOTE: The procedure to open the control panel varies by operating system. If
you are not sure how to do this, see the Windows Help.
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2. Select HP Deskjet All-In-One Driver Software, and then click Change/Remove.
Follow the onscreen instructions.

3. Disconnect the product from your computer.

4. Restart your computer.

Bf NOTE: Itis important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.

5. Insert the product CD-ROM into your computer’'s CD-ROM drive and then start the
Setup program.

6. Follow the onscreen instructions and the instructions provided in the Setup Guide that
came with the product.

When the software installation is complete, the HP Digital Imaging Monitor icon appears

in the Windows system tray.

To verify that the software is properly installed, double-click the HP Solution Center icon
on the desktop. If the HP Solution Center shows the essential icons (Scan Picture and
Scan Document), the software has been properly installed.
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Paper jams
To help avoid paper jams, follow these guidelines:
+ Remove printed papers from the output tray frequently.
Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.

Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure
the paper-width guide does not bend the paper in the input tray.

Do not force paper too far forward in the input tray.
+ Use paper types that are recommended for the product.
For more information, see the following topics:

Clear paper jams
* Information on paper

Clear paper jams
Solution: Clear the paper jam through the rear access door.

To clear a paper jam from the rear access door

1. Press in the tab on the left side of the rear access door to release the door.
Remove the door by pulling it away from the product.

/\ CAUTION: Trying to clear a paper jam from the front of the product can
damage the print mechanism. Always access and clear paper jams through
the rear access door.

2. Gently pull the paper out of the rollers.

/\ CAUTION: Ifthe paper tears when you are removing it from the rollers, check
the rollers and wheels for torn pieces of paper that might be remaining inside
the product. If you do not remove all the pieces of paper from the product,
more paper jams are likely to occur.
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3. Replace the rear access door. Gently push the door forward until it snaps into
place.

4. Press any button on the control panel to continue the current job.

Cause: Paper had jammed in the product.

Information on paper
The HP All-in-One is designed to work well with most paper types. Test a variety of paper
types before buying a large quantity. Find a paper type that works well and is easy to
purchase. HP Premium papers are designed for the best quality results. In addition, follow
these tips:

Do not use paper that is too thin, that has a slick texture, or that stretches easily. It
can feed incorrectly through the paper path, causing paper jams.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag.

Do not leave unused photo paper in the input tray. The paper might start to curl, which
might reduce the quality of your printouts. Curled paper can also cause paper jams.
Always hold photo paper by the edges. Fingerprints on photo paper can reduce print
quality.

Do not use paper that is heavily textured. It can cause graphics or text to print
improperly.

Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.

Store printed photos under glass or in a storage book to prevent bleeding over time
from high humidity. Use HP Premium Plus photo paper for maximum performance.

Print cartridge troubleshooting

If you are experiencing problems with printing, you might have a problem with one of the
print cartridges. If you receive an error message about the print cartridges, see Print
cartridge messages for more information.

Try the following:

Information on print cartridges
Resolving print cartridge problems
Resolving print cartridge error messages
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Information on print cartridges

94

For best results, use HP print cartridges. The following tips help maintain HP print
cartridges and ensure consistent print quality.

Keep all print cartridges in the original sealed packages until they are needed.
Store print cartridges at room temperature (15.6°-26.6° C or 60°-78° F).

Do not reattach the protective tape once it has been removed from the print cartridge.
Reattaching the plastic tape might damage the print cartridge. Place the print cartridge
in the product immediately after removing the plastic tape. If this is not possible, store
it in a print cartridge protector or airtight plastic container.

HP recommends that you do not remove the print cartridges from the product until
you have replacement print cartridges available to install.

Turn off the product from the control panel. Do not turn off the product by turning off
a power strip or unplugging the power cord from the product. If you improperly turn
off the product, the print carriage does not return to the correct position and the print
cartridges can dry out.

Do not open the print cartridge door unless necessary. This exposes the print
cartridges to air, which reduces the life of the print cartridges.

Br NOTE: If you leave the print cartridge door open for a long period of time, the
product will recap the print cartridges to protect them from exposure to air.

It might be necessary to clean the print cartridges when you notice a significant
decrease in print quality.

{r TIP: You might notice a decrease in print quality if the print cartridges have not
been used for a long time.

Do not clean the print cartridges unnecessarily. This wastes ink and shortens the life
of the cartridges.

Handle print cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems. If print quality is poor right after
cartridge installation, allow half an hour for the print cartridge to recover.

For more information, see:

Print cartridge troubleshooting
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Resolving print cartridge problems

Many problems can be resolved with the following procedures. If you receive a specific
error message about the print cartridges, see Print cartridge messages for more
information.

To troubleshoot the print cartridges
1. Remove and reinstall the print cartridges.
For more information, see Replace the print cartridges.

Bf NOTE: Make sure the plastic tape has been removed. If it is still covering the ink
nozzles, gently remove the plastic tape by using the pink pull tab.
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2. If print quality is suffering, check the estimated ink levels.
For more information, see Check the estimated ink levels.
3. Print a self-test report and review the test patterns.
For more information, see Print a self-test report.
4. Clean the print cartridges:
» First, try cleaning the print cartridges from the HP Photosmart Software. For more
information, see Clean the print cartridges.

/\ CAUTION: Performing this procedure unnecessarily can waste ink and
shorten the life of the cartridges.

« If cleaning the print cartridges from the software did not help, you can try cleaning
the print cartridge contacts. For more information, see Clean the print cartridge
contacts.

5. If none of the previous procedures resolved the problem, replace the print cartridges.

For more information, see Replace the print cartridges.

Resolving print cartridge error messages

After you install a print cartridge, one or both of the print cartridge status lights begin to
blink. The printer will not print. One of the following messages may appear on your
computer screen:

Print Cartridge Problem
Incorrect Print Cartridge(s)
Incorrectly Installed Cartridge(s)
Print Cartridge(s) Missing

Work through the following sections in order. When the print cartridge light stops blinking,
you have solved the problem.
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Bf NOTE: In the procedures below, the problem cartridge is identified by the blinking
light. The light on the left blinks when the tri-color print cartridge (on the left) is the
problem, the light on the right blinks when the black or photo cartridge (on the right)
is the problem, and both lights blink when both cartridges are the problem.

» Solution 1: Remove and reinstall the print cartridges
» Solution 2: Clean the print cartridge contacts
* Solution 3: Print in ink-backup mode

Solution 1: Remove and reinstall the print cartridges

Solution: The print cartridge may not have full electrical contact with the printer.
Removing and reinstalling the cartridge may help.
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BY NOTE: HP cannot guarantee the quality of remanufactured or refilled cartridges.

To verify and install the correct print cartridges
1. Make sure the product is on. Press the On button if it is not lit.

2. Open the print cartridge door, and then wait until the print carriage is idle and
silent.

3. Press down lightly on the end of the problem cartridge to release it.
4. Slide the cartridge out and inspect it:

/\ CAUTION: Do not touch the copper electrical contacts or the ink nozzles.

» Check the electrical contacts for debris.
» Make sure all the clear nozzle protective tape has been removed.

/\ CAUTION: Do not attempt to remove the copper electrical strip!

5. Read the selection number on the print cartridge label and make sure it is
compatible with the product. Compatible print cartridges are listed in the printed
documentation that came with the product.

1 | Selection number
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6. If the print cartridge has the wrong selection number, install a new print cartridge.
For more information, see Replace the print cartridges.

7. Close the print cartridge door.
If this did not solve the issue, try the next solution.

Solution 2: Clean the print cartridge contacts

Solution: If the print cartridge selection number is correct and the previous solution
did not resolve the problem, try cleaning the print cartridge. For more information, see
Clean the print cartridge contacts.

If the print cartridge status light continues to flash after cleaning the print cartridge,
replace the print cartridge. For more information, see Replace the print carfridges.

If this did not solve the issue, try the next solution.
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Solution 3: Print in ink-backup mode

Solution: If you do not have a replacement print cartridge, you can still print in ink
backup mode. Remove the problem cartridge and print with the remaining cartridge.

For more information, see:
Use ink-backup mode
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Print quality troubleshooting

98

If you are having problems with print quality, try the solutions in this section and observe
the following guidelines.

To troubleshoot print quality issues

1. Check the print cartridges.
HP recommends that you use genuine HP print cartridges. Genuine HP print
cartridges are designed and tested with HP printers to help you easily produce great
results, time after time.

Bf NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using a non-HP supply will not be covered
under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

For more information, see Replace the print cartridges.

2. Check the ink levels.
If you have installed a refilled or remanufactured print cartridge, or a cartridge that
has been used in another printer, the ink level indicator will be inaccurate or
unavailable. The ink levels provided are an estimate. When print cartridges are truly
low on ink, printouts will be faded or streaked. As long as print quality is acceptable,
there is no reason to replace print cartridges. Low ink warnings are provided for
planning purposes only.
For more information, see Check the estimated ink levels.

3. Make sure you turn off the product by pressing the On button.

/\ CAUTION: Do not turn off the product by turning off a power strip or unplugging
the power cord from it. If you improperly turn off the product, the print carriage
does not return to the correct position and the print cartridges can dry out.

4. To achieve the best print quality, HP recommends using HP papers that are
specifically designed for the type of project you are printing along with genuine HP
ink. HP papers and HP ink are specifically designed to work well together to provide
high-quality output.

5. Check the product settings to make sure that the print mode and paper selection is
correct for the paper and the task.

For more information, see Set the paper type for printing and Choose papers for
printing and copying.

6. If the cartridges are genuine HP and the product is not in backup mode, print a self-
test report to determine if the product and ink supplies are operating correctly.

This will use one sheet of plain paper and a very small amount of ink.
For more information, see Print a self-test report.
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7. Evaluate the self-test report.

For additional print cartridge troubleshooting, visit the HP Web site at www.hp.com/
su

If the self-test report shows a defect, try the following:
* Clean the print cartridges automatically. For more information, see Clean the print

cartridges.
» If you are missing lines when you print, clean the electrical contacts. For more
information, see Clean the print cartridge contacts.

* Replace the print cartridge. For more information, see Replace the print

cartridges.
For more information, see Print a self-test report.

If the self-test report does not show a problem, investigate other causes, such as the
image file or software program.
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ort.

This section contains the following topics:

Wrong, inaccurate, or bleeding colors

Ink is not filling the text or graphics completely
The printout has a horizontal band of distortion near the bottom of a borderless print
Printouts have horizontal streaks or lines
Printouts are faded or have dull colors
Printouts seem blurry or fuzzy

Printouts have vertical streaks

Printouts are slanted or skewed

Ink streaks on the back of the paper

Paper is not picked up from the input tray

The text edges are jagged

Wrong, inaccurate, or bleeding colors

If your printout has one of the following print quality problems, try the solutions in this
section for help.

Colors look different than what you expected.

For example, the colors in your graphic or photo look one way on your computer
screen but print out differently, or magenta was replaced with cyan in your printout.
Colors run into each other, or look like they are smeared on the page. The edges
might have a feathering appearance instead of being sharp and defined.

Try the following solutions if the colors appear wrong, inaccurate, or bleed into each other.

Solution 1: HP recommends using genuine HP print cartridges
Solution 2: Check the paper loaded in the input tray

Solution 3: Check the paper type

Solution 4: Check to see if the product is in ink-backup mode
Solution 5: Check the print settings

Solution 6: Clean the print cartridges

Solution 1: HP recommends using genuine HP print cartridges

Solution: Check to see if your print cartridges are genuine HP print cartridges.
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HP recommends that you use genuine HP print cartridges. Genuine HP print
cartridges are designed and tested with HP printers to help you easily produce great
results, time after time.

BY NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using a non-HP supply will not be covered
under warranty.

If you believe you purchased genuine HP print cartridges, go to:

www.hp.com/go/anticounterfeit

Cause: Non-HP ink was being used.
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If this did not solve the issue, try the next solution.

Solution 2: Check the paper loaded in the input tray
Solution: Make sure the paper is loaded correctly and that it is not wrinkled or too
thick.

+ Load paper with the side you want to print on facing down. For example, if you
are loading glossy photo paper, load the paper with the glossy side down.

« If the paper is too close to the print cartridge during printing, the ink might be
smeared. This can happen if the paper is raised, wrinkled, or very thick, such as
a mailing envelope. Make sure the paper lays flat in the input tray and is not
wrinkled.

For more information, see:

* Load paper
* Information on paper

Cause: The paper was loaded incorrectly, or it was wrinkled or too thick.
If this did not solve the issue, try the next solution.

Solution 3: Check the paper type

Solution: HP recommends that you use HP Premium Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Premium Plus Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

BY NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.
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For more information, see:

* Recommended papers for printing and copying
* Information on paper

Cause: The wrong kind of paper was loaded in the input tray.
If this did not solve the issue, try the next solution.

Solution 4: Check to see if the product is in ink-backup mode

Solution: Check to see if the the product is printing in ink-backup mode, with only
one print cartridge installed.

If the product is in ink-backup mode, text and photo quality will differ from those printed
when using both print cartridges.
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If you are satisfied with the print quality, continue printing in ink-backup mode. Or,
replace the missing print cartridge.

For more information, see:

* Use ink-backup mode
* Replace the print cartridges

Cause: A print cartridge was missing and the product was printing in ink-backup
mode.

If this did not solve the issue, try the next solution.

Solution 5: Check the print settings

Solution: Check the print settings.

»  Check the print settings to see if the color settings are incorrect.
For example, check to see if the document is set to print in grayscale. Or, check
to see if advanced color settings such as saturation, brightness, or color tone, are
set to modify the appearance of colors.

»  Check the print quality setting and make sure it matches the type of paper loaded
in the product.
You might need to choose a lower print quality setting, if colors are running into
each other. Or, choose a higher setting if you are printing a high-quality photo,
and then make sure photo paper such as HP Premium Photo Papers, is loaded
in the input tray.

EY NOTE: Onsome computer screens, colors might appear differently than they do
when printed on paper. In this case, there is nothing wrong with the product, print
settings, or print cartridges. No further troubleshooting is required.

For more information, see:

* Change the print speed or quality
» Choose papers for printing and copying

Cause: The print settings were set incorrectly.
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If this did not solve the issue, try the next solution.

Solution 6: Clean the print cartridges

Solution: Print a self-test report to determine if there is a problem with the print
cartridges. If the self-test report shows a problem, clean the print cartridges. If the
problem persists, you might need to replace the print cartridges.

For more information on print cartridges, see Print cartridge troubleshooting.

Cause: The print cartridges need to be cleaned.

Ink is not filling the text or graphics completely
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Try the following solutions if the ink is not filling the text or image completely so that it
appears that parts are missing or blank.

* Solution 1: HP recommends using genuine HP print cartridges

» Solution 2: Check the print settings

»  Solution 3: Check the paper type

» Solution 4: Clean the print cartridges

Solution 1: HP recommends using genuine HP print cartridges
Solution: Check to see if your print cartridges are genuine HP print cartridges.

HP recommends that you use genuine HP print cartridges. Genuine HP print
cartridges are designed and tested with HP printers to help you easily produce great
results, time after time.

Bf NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using a non-HP supply will not be covered
under warranty.

If you believe you purchased genuine HP print cartridges, go to:
www.hp.com/go/anticounterfeit

Cause: Non-HP ink was being used.
If this did not solve the issue, try the next solution.

Solution 2: Check the print settings

Solution: Check the print settings.

«  Check the paper type setting to make sure it matches the type of paper loaded in
the input tray.

«  Check the quality setting. Use a higher quality setting to increase the amount of
ink used for printing.
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For more information, see:

» Set the paper type for printing

* Change the print speed or quality

*  Print using Maximum dpi

» Change copy speed

Cause: The paper type or print quality settings were incorrectly.
If this did not solve the issue, try the next solution.
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Solution 3: Check the paper type

Solution: HP recommends that you use HP Premium Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Premium Plus Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

+ Recommended papers for printing and copying

» Information on paper

Cause: The wrong kind of paper was loaded in the input tray.

If this did not solve the issue, try the next solution.

Solution 4: Clean the print cartridges

Solution: Print a self-test report to determine if there is a problem with the print
cartridges. If the self-test report shows a problem, clean the print cartridges. If the
problem persists, you might need to replace the print cartridges.

For more information on print cartridges, see Print cartridge troubleshooting.

Cause: The print cartridges need to be cleaned.

The printout has a horizontal band of distortion near the bottom of a borderless
print
Try the following solutions if your borderless print has a blurry band or line on the bottom
of it.
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Bf NOTE: There is no problem with the ink supplies and replacing the print cartridges
is unnecessary.

» Solution 1: Check the paper type
» Solution 2: Check the print quality setting
» Solution 3: Rotate the image

Solution 1: Check the paper type

Solution: HP recommends that you use HP Premium Papers or any other paper
type that is appropriate for the product.
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Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Premium Plus Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

BY NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

« Recommended papers for printing and copying
* Information on paper

Cause: The wrong kind of paper was loaded in the input tray.
If this did not solve the issue, try the next solution.

Solution 2: Check the print quality setting

Solution: Check the quality setting. Use a higher quality setting to increase the
amount of ink used for printing.

Bf NOTE: For maximum dpi resolution, go to the Advanced tab, and then select
Enabled from the Maximum dpi drop-down list. For more information, see Print
using Maximum dpi.

For more information, see:

* Change the print speed or quality
e Print using Maximum dpi

* Change copy speed

Cause: The print quality setting was set too low.
If this did not solve the issue, try the next solution.
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Solution 3: Rotate the image

Solution: If the problem persists, use the software you installed with the product or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page.

For more information, see:
Change the page orientation

Cause: The photo image had light blue, gray, or brown hues that print near the
bottom of the page.

Printouts have horizontal streaks or lines
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Try the following solutions if your printout has lines, streaks, or marks on it that run side-
to-side across the width of the page.

Solution 1: Make sure the paper is loaded correctly

Solution 2: Check the print quality setting

Solution 3: If the print cartridge was dropped, wait for it to recover
Solution 4: Clean the print cartridge nozzles

Solution 5: Clean the print cartridges

Solution 1: Make sure the paper is loaded correctly

Solution: Make sure the paper is loaded correctly.
For more information, see:

Load full-size paper

Cause: The paper was not feeding properly or was not loaded correctly.
If this did not solve the issue, try the next solution.

Solution 2: Check the print quality setting

Solution: Check the quality setting. Use a higher quality setting to increase the
amount of ink used for printing.

F.%Y NOTE: For maximum dpi resolution, go to the Advanced tab, and then select
Enabled from the Maximum dpi drop-down list. For more information, see Print
using Maximum dpi.

For more information, see:

* Change the print speed or quality
*  Print using Maximum dpi

* Change copy speed

Cause: The print quality setting was set too low.
If this did not solve the issue, try the next solution.
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Solution 3: If the print cartridge was dropped, wait for it to recover

Solution: Allow 30 minutes for the print cartridge to recover.

Cause: A tri-color or photo print cartridge was jarred or handled roughly during
installation.

If this did not solve the issue, try the next solution.

Solution 4: Clean the print cartridge nozzles

Solution: Check the print cartridges. If it looks as though there are fibers or dust
around the ink nozzles, clean the ink nozzle area of the print cartridge.

For more information, see:

Clean the area around the ink nozzles

Cause: The print cartridge nozzles needed to be cleaned.
If this did not solve the issue, try the next solution.

Solution 5: Clean the print cartridges

Solution: Check the estimated ink levels remaining in the print cartridges.

BY NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the print cartridges until print quality becomes unacceptable.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information, see:
*  Print cartridge troubleshooting
e Print a self-test report

Cause: The print cartridges needed to be cleaned or there was insufficient ink.

Printouts are faded or have dull colors
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Try the following solutions if the colors in your printout are not as bright and intense as
you expected.

Solution 1: Check the print settings

Solution 2: Check the paper type

Solution 3: If you are making a copy, place a protective sheet on the glass

Solution 4: Clean the glass

Solution 5: Clean the print cartridges
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Solution 1: Check the print settings

Solution: Check the print settings.

»  Check the paper type setting to make sure it matches the type of paper loaded in
the input tray.

+  Check the quality setting. Use a higher quality setting to increase the amount of
ink used for printing.

For more information, see:

» Set the paper type for printing

* Change the print speed or quality

*  Print using Maximum dpi

» Change copy speed
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Cause: The paper type or print quality settings were set incorrectly.

If this did not solve the issue, try the next solution.

Solution 2: Check the paper type

Solution: HP recommends that you use HP Premium Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Premium Plus Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

+ Recommended papers for printing and copying
* Information on paper
Cause: The wrong kind of paper was loaded in the input tray.

If this did not solve the issue, try the next solution.

Solution 3: If you are making a copy, place a protective sheet on the glass

Solution: If you are making a copy, try placing one or more clear plastic sheet
protectors directly on the glass, and then place the original print side down on top of
the sheet protectors.

Cause: The quality of the original was poor.

If this did not solve the issue, try the next solution.
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Solution 4: Clean the glass
Solution: Clean the glass and lid backing.
For more information, see:
* Clean the lid backing

+ Clean the glass

Cause: Debris might be stuck on the glass or on the back of the document lid; this
causes poor copy quality and slows down processing.

If this did not solve the issue, try the next solution.
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Solution 5: Clean the print cartridges

Solution: Check the estimated ink levels remaining in the print cartridges.

BY NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the print cartridges until print quality becomes unacceptable.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information, see:
e Print cartridge troubleshooting
e Print a self-test report

Cause: The print cartridges needed to be cleaned or there was insufficient ink.

Printouts seem blurry or fuzzy
Try the following solutions if your printout is smudged or unclear.

B NOTE: There is no problem with the ink supplies and replacing the print cartridges
is unnecessary.

4‘_} TIP: After reviewing the solutions in this section, you can go to HP's support Web
site to see if there is additional troubleshooting help. For more information, go to:
www.hp.com/support.

» Solution 1: Check the print settings
* Solution 2: Check the resolution of the image
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Solution 1: Check the print settings

Solution: Check the print settings.

»  Check the paper type setting to make sure it matches the type of paper loaded in
the input tray.

+  Check the quality setting. Use a higher quality setting to increase the amount of
ink used for printing.

For more information, see:

» Set the paper type for printing

* Change the print speed or quality

*  Print using Maximum dpi

» Change copy speed

(=2
c
=
[<}
o
<
0
o
2
=}
e
[

Cause: The paper type or print quality settings were set incorrectly.

If this did not solve the issue, try the next solution.

Solution 2: Check the resolution of the image

Solution: Check the resolution of the image. If you are printing a photo or graphic,
and the resolution is too low, it will be blurry or fuzzy when printed.

If a digital photo or rasterized graphic has been resized, it can be blurry or fuzzy when
printed.

Cause: The resolution of the image was low.

Printouts have vertical streaks

Refer to this section if your printout has a lines, streaks, or marks on it that run up-
and-down or lengthwise down the page.

B NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

Solution: HP recommends that you use HP Premium Papers or any other paper
type that is appropriate for the product.

Always make sure the paper you are printing on is flat. For best results when printing
images, use HP Premium Plus Photo Paper.

Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag. This will prevent the photo paper from curling.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

For more information, see:

 Recommended papers for printing and copying
* Information on paper
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Cause: The wrong kind of paper was loaded in the input tray.

Printouts are slanted or skewed
Try the following solutions if your printout does not appear straight on the page.

* Solution 1: Make sure the paper is loaded correctly
» Solution 2: Make sure only one type of paper is loaded
» Solution 3: Check the rear access door

Solution 1: Make sure the paper is loaded correctly
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Solution: Make sure the paper is loaded correctly.
For more information, see:

Load full-size paper

Cause: The paper was not feeding properly or was not loaded correctly.
If this did not solve the issue, try the next solution.

Solution 2: Make sure only one type of paper is loaded
Solution: Load only one type of paper at a time.
Cause: More than one type of paper was loaded in the input tray.
If this did not solve the issue, try the next solution.

Solution 3: Check the rear access door
Solution: Make sure the rear access door is securely installed.
Cause: The rear access door was not securely installed.

Ink streaks on the back of the paper
Try the following solutions if there is smeared ink on the back of your printout.

» Solution 1: Print on a page of plain paper
» Solution 2: Wait while the ink dries

Solution 1: Print on a page of plain paper

Solution: Print one or several pages of plain paper to soak up any excess ink in
the product.

To remove excess ink using plain paper

1. Load several sheets of plain paper in the input tray.
2. Wait five minutes.
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3. Print a document with little or no text.

4. Check the back of the paper for ink. If there is still ink on the back of the paper,
try printing on another page of plain paper.

Cause: Ink accumulated inside the product, where the back of the paper rests

during printing.

If this did not solve the issue, try the next solution.

Solution 2: Wait while the ink dries

Solution: Wait at least thirty minutes for the ink inside the product to dry, then try
the print job again.
Cause: The excess ink in the product needed to dry out.

Paper is not picked up from the input tray

Solution:

Do one of the following:

+ If the product is out of paper or there are only a few sheets remaining, load more
paper in the input tray.

« If there is paper in the input tray:

* Remove the stack of paper from the input tray and verify that all the paper in
the input tray is the same size and type.

* Replace any paper that is ripped, dusty, wrinkled, or bent.
If the paper is curled, uncurl the paper by gently bending it in the opposite
direction of the curl or replace the paper.

» Tap the stack of paper on a flat surface to align the edges.
» Verify that the stack of paper contains between 10 and 25 sheets of paper.
* Reload the paper into the input tray.

Follow the prompts on the display to continue.

Cause: There was not enough paper in the input tray.

The text edges are jagged

Try the following solutions if the text in your printouts is not sharp and the edges are
rough.

Bf NOTE: There is no problem with the ink supplies and replacing the print
cartridges is unnecessary.

Solution: Use TrueType or OpenType fonts to ensure that the product is able to
print smooth fonts. When selecting a font, look for the TrueType or OpenType icon.

Some software applications offer custom fonts that have jagged edges when enlarged
or printed. Also, if you want to print bitmapped text, it might have jagged edges when
enlarged or printed.
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Cause: The font was a custom size.

Print troubleshooting

Use this section to solve these printing problems:

» Envelopes print incorrectly

» Borderless printing produces unexpected results

* The product is not responding

» The product prints meaningless characters

* Nothing happens when | try to print

» The pages in my document came out in the wrong order

» The margins are not printing as expected

» Text or graphics are cut off at the edge of the page

» A blank page came out while printing

* Ink is spraying the inside of the HP All-in-One when | print a photo

-
=
o
c
=
®
()
=2
o
o
(=3
=

«Q

Envelopes print incorrectly

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Reload the envelopes in the input tray

+ Solution 2: Load a different type of envelope

Solution 1: Reload the envelopes in the input tray

Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and on the left.

Bf NOTE: To avoid paper jams, tuck the flaps inside the envelopes.

Cause: A stack of envelopes was loaded incorrectly.
If this did not solve the issue, try the next solution.

Solution 2: Load a different type of envelope

Solution: Do not use shiny or embossed envelopes or envelopes that have clasps
or windows.
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Cause: The wrong type of envelope was loaded.

Borderless printing produces unexpected results

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

Solution 1: Print from the HP Photosmart Software

Solution 1: Print from the HP Photosmart Software
Solution 2: Use the appropriate media
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Solution: Try printing the image from the photo imaging software that came with
the product.

Cause: Printing a borderless image from a non-HP software application produced
unexpected results.

If this did not solve the issue, try the next solution.

Solution 2: Use the appropriate media

Solution: To print a borderless image, use 10 x 15 cm (4 x 6 inch) HP Premium
Plus Photo Papers with a tear-off tab. When you remove the tear-off tab, the printed
image is borderless and extends to the edges of the paper.

For more information, see:

Print a borderless image

Cause: Use of inappropriate media.

The product is not responding

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

Solution 1: Wait for the product to finish other tasks
Solution 2: Check for a paper jam

Solution 3: Load more paper in the input tray

Solution 4: Check for a print carriage stall

Solution 5: Check the cable connections to the product
Solution 6: Make sure that the product is turned on
Solution 7: Restart the product

Solution 8: Check the print driver status

Solution 9: Check the print queue for canceled jobs
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Solution 1: Wait for the product to finish other tasks

Solution: If the product is performing another task such as copying or scanning,
your print job will be delayed until the product completes the current task.

Some documents take a long time to print. If nothing has printed several minutes after
you sent a print job to the product, check your computer to see if there are any
messages.

Cause: The product was busy with another task.
If this did not solve the issue, try the next solution.

Solution 2: Check for a paper jam
Solution: Clear the paper jam.
For more information, see:
Clear paper jams
Cause: The product had a paper jam.
If this did not solve the issue, try the next solution.

Solution 3: Load more paper in the input tray
Solution: Load paper in the input tray.
For more information, see:

Load full-size paper

Cause: The product was out of paper.
If this did not solve the issue, try the next solution.

Solution 4: Check for a print carriage stall

Solution: Turn off the product, open the print cartridge door, and remove any
objects that are blocking the print carriage (including any packing materials), and then
turn on the product.

For more information, see:

The print carriage is stalled
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Cause: The print carriage has stalled.
If this did not solve the issue, try the next solution.

Solution 5: Check the cable connections to the product
Solution: If the product is not properly connected to the computer, communication
errors can occur. Try the following:
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If the connections are secure, and nothing has printed several minutes after you sent
a print job to the product, check the status of the product. In the HP Photosmart
Software, click Settings, and then click Status.

For more information, see:
After setting up the product, it does not print
Cause: The computer was not communicating with the product.

If this did not solve the issue, try the next solution.

Solution 6: Make sure that the product is turned on

Solution: Look at the On button located on the product. If it is not lit, the product is
turned off. Make sure the power cord is firmly connected to the product and plugged
into a power outlet. Press the On button to turn on the product.

Cause: The product was turned off.
If this did not solve the issue, try the next solution.

Solution 7: Restart the product

Solution: Turn off the product, and then unplug the power cord. Plug the power
cord back in, and then press the On button to turn on the product.
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Cause: The product experienced an error.
If this did not solve the issue, try the next solution.

Solution 8: Check the print driver status

Solution: The printer driver status might have changed to either offline or stop
printing.

To check the printer driver status
1. In the HP Solution Center, click the Settings tab.
2. Click Status.
If the status is Offline or Stop printing, change the status to Ready.
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Cause: The status of the printer driver has changed.

If this did not solve the issue, try the next solution.

Solution 9: Check the print queue for canceled jobs

Solution: A print job might remain in the queue after it has been cancelled. The
cancelled print job jams the queue and prevents the next print job from printing.

From your computer, open the printer folder and see if the cancelled job remains in
the print queue. Try to delete the job from the queue. If the print job remains in the
queue, try one or both of the following:

« Disconnect the USB cable from the product, restart the computer, and then
reconnect the USB cable to the product.

«  Shut down the product, restart the computer, and then restart the product.
Cause: A deleted print job was still in the queue.

The product prints meaningless characters

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Restart the product and your computer

» Solution 2: Try printing another document

Solution 1: Restart the product and your computer

Solution: Turn off the product and your computer for 60 seconds, then turn them
both on and try printing again.

Cause: The memory in the product was full.

If this did not solve the issue, try the next solution.
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Solution 2: Try printing another document

Solution: Try printing another document from the same software application. If this
works, then try printing a previously saved version of the document that is not corrupt.

Cause: The document was corrupt.

Nothing happens when | try to print

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
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Solution 1: Make sure that the product is turned on

Solution 2: Wait for the product to finish other tasks

Solution 3: Make sure that the product is the selected printer
Solution 4: Check the cable connections to the product
Solution 5: Load more paper in the input tray

Solution 6: Check for a paper jam

Solution 7: Check for a print carriage stall

Solution 1: Make sure that the product is turned on

Solution: Look at the On button located on the product. If it is not lit, the product is
turned off. Make sure the power cord is firmly connected to the product and plugged
into a power outlet. Press the On button to turn on the product.

Cause: The product was turned off.
If this did not solve the issue, try the next solution.

Solution 2: Wait for the product to finish other tasks

Solution: If the product is performing another task such as copying or scanning,
your print job will be delayed until the product completes the current task.

Some documents take a long time to print. If nothing has printed several minutes after
you sent a print job to the product, check the product display to see if there are any
messages.

Cause: The product was busy with another task.

If this did not solve the issue, try the next solution.

Solution 3: Make sure that the product is the selected printer

Solution: Make sure the product is the selected printer in your software application.

{r TIP: You can set the product as the default printer to ensure that the printer is
automatically selected when you select Print in the File menu of your different
software applications.

Cause: The product was not the selected printer.
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If this did not solve the issue, try the next solution.

Solution 4: Check the cable connections to the product

Solution: If the product is not properly connected to the computer, communication
€errors can occur.
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If the connections are secure, and nothing has printed several minutes after you sent
a print job to the product, check the status of the product. In the HP Photosmart
Software, click Settings, and then click Status.

For more information, see:

After setting up the product, it does not print

Cause: The computer was not communicating with the product.
If this did not solve the issue, try the next solution.

Solution 5: Load more paper in the input tray
Solution: Load paper in the input tray.
For more information, see:

Load full-size paper

Cause: The product was out of paper.
If this did not solve the issue, try the next solution.
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Solution 6: Check for a paper jam
Solution: Clear the paper jam.
For more information, see:
Clear paper jams
Cause: The product had a paper jam.
If this did not solve the issue, try the next solution.

Solution 7: Check for a print carriage stall

Solution: Turn off the product, open the print cartridge door, and remove any
objects that are blocking the print carriage (including any packing materials), and then
turn on the product.

(=2
c
=
[<}
o
<
0
o
2
=}
e
[

For more information, see:

The print carriage is stalled
Cause: The print carriage has stalled.

The pages in my document came out in the wrong order

Solution: Print the document in reverse order. When the document finishes
printing, the pages will be in correct order.

For more information, see:
Print a multiple-page document in reverse order

Cause: The print settings were set to print the first page of your document first.
Because of the way the paper feeds through the product, this means the first page
will be print side up at the bottom of the stack.

The margins are not printing as expected

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Set the correct margins in your software application

« Solution 2: Make sure that the paper size setting is correct
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» Solution 3: Check the paper guide position
» Solution 4: Make sure the stack of envelopes is loaded correctly

Solution 1: Set the correct margins in your software application
Solution: Check the printer margins.

Make sure the margin settings for the document do not exceed the printable area of
the product.

To check your margin settings
1. Preview your print job before sending it to the product.
In most software applications, click the File menu, and then click Print Preview.
2. Check the margins.
The product uses the margins you have set in your software application, as long
as they are greater than the minimum margins the product supports. For more
information about setting margins in your software application, see the
documentation that came with the software.

3. Cancelthe printjob if the margins are not satisfactory, and then adjust the margins
in your software application.
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Cause: The margins were not set correctly in your software application.
If this did not solve the issue, try the next solution.

Solution 2: Make sure that the paper size setting is correct

Solution: Verify that you have selected the proper paper size setting for your
project. Make sure that you have loaded the correct paper size in the input tray.

For example, in some countries/regions you may need to specify A4 as the paper
size if A (letter) is the default value.

For more information, see:
Set the paper type for printing

Cause: The paper size setting was not set correctly for the project you were printing.
If this did not solve the issue, try the next solution.

Solution 3: Check the paper guide position

Solution: Remove the stack of paper from the input tray, and then reload the paper.
Make sure that you slide the paper-width guide to the right until it stops at the edge
of the paper.

For more information, see:

Load paper

Cause: The paper guides are not positioned correctly.
If this did not solve the issue, try the next solution.
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Solution 4: Make sure the stack of envelopes is loaded correctly

Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and on the left.

B NOTE: To avoid paper jams, tuck the flaps inside the envelopes.
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For more information, see:

Load envelopes
Cause: A stack of envelopes was loaded incorrectly.

Text or graphics are cut off at the edge of the page

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Check the margins in your software application

* Solution 2: Make sure the document can fit on a supported paper size

» Solution 3: Remove and reload the paper in the input tray

Solution 1: Check the margins in your software application

Solution: Make sure the margin settings for the document do not exceed the
printable area of the product.

To check your margin settings

1. Preview your print job before sending it to the product.
In most software applications, click the File menu, and then click Print Preview.

2. Check the margins.
The product uses the margins you have set in your software application, as long
as they are greater than the minimum margins the product supports. For more
information about setting margins in your software application, see the
documentation that came with the software.

3. Cancelthe printjob if the margins are not satisfactory, and then adjust the margins
in your software application.

Cause: The margins are not set correctly in your software application.
If this did not solve the issue, try the next solution.
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Solution 2: Make sure the document can fit on a supported paper size

Solution: Make sure the layout of the document you are trying to print fits on a paper
size supported by the product.

To preview the print layout
1. Load the correct paper size into the input tray.
2. Preview your print job before sending it to the product.
In most software applications, click the File menu, and then click Print Preview.

3. Check the graphics in the document to make sure that the current size fits within
the printable area of the product.

4. Cancel the print job if the graphics do not fit in the printable area of the page.

{} TIP: Some software applications allow you to scale the document to fit the paper
size currently selected. Additionally, you can scale the size of a document from
the print Properties dialog box.

Cause: The size of the document you are printing is larger than the paper loaded
in the input tray.

If this did not solve the issue, try the next solution.

Solution 3: Remove and reload the paper in the input tray
Solution: If the paper is misfeeding, it could cause parts of the document to cut off.

Remove the stack of paper from the input tray, and then reload the paper. Make sure
that you slide the paper-width guide inward until it stops at the edge of the paper.

For more information, see:

Load full-size paper

Cause: The paper is loaded incorrectly.

A blank page came out while printing

122

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Check the ink levels in the print cartridges

» Solution 2: Check for blank pages at the end of the document

» Solution 3: Load more paper in the input tray

» Solution 4: Check the print cartridges for protective tape

Solution 1: Check the ink levels in the print cartridges

Solution: Check the estimated ink levels remaining in the print cartridges.
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B NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the print cartridges until print quality becomes unacceptable.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information on print cartridges, see Print cartridge troubleshooting.

Cause: If you are printing black text, and a blank page comes out of the product,
the black print cartridge might be empty.

If this did not solve the issue, try the next solution.
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Solution 2: Check for blank pages at the end of the document

Solution: Open the documentfile in your software application and remove any extra
pages or lines at the end of the document.

Cause: The document you are printing contains an additional blank page.

If this did not solve the issue, try the next solution.

Solution 3: Load more paper in the input tray

Solution: If the product has only a few sheets remaining, load more paper in the
input tray. If there is plenty of paper in the input tray, remove the paper, tap the stack
of paper against a flat surface, and reload the paper into the input tray.

For more information, see:
Load full-size paper
Cause: The product picked up two sheets of paper.

If this did not solve the issue, try the next solution.

Solution 4: Check the print cartridges for protective tape

Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
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covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.
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Copper-colored contacts

2 | Plastic tape with pink pull tab (must be removed before installing)

3 | Ink nozzles under tape

59

For more information, see:

Replace the print cartridges

Cause: The protective plastic tape was only partially removed from the print
cartridge.

Ink is spraying the inside of the HP All-in-One when | print a photo

Solution: Make sure you load photo paper in the input tray before you print a
borderless print job.

Cause: The borderless print settings require photo paper to be loaded in the input
tray. You are using the wrong paper type.

Copy troubleshooting

Use this section to solve these copy problems:

* Nothing happens when | try to copy

» Parts of the original do not appear or are cut off

+ The printout appears enlarged on the page

* The printout is blank

* A borderless copy has white space around the edges
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Nothing happens when | try to copy

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

Solution 1: Make sure that the product is turned on

Solution 1: Make sure that the product is turned on

Solution 2: Make sure that the original is placed correctly on the glass

Solution 3: Wait for the product to finish other tasks

Solution 4: Make sure the paper loaded is recognized by the product
Solution 5: Check for a paper jam
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Solution: Look at the On button located on the product. If it is not lit, the product is
turned off. Make sure the power cord is firmly connected to the product and plugged
into a power outlet. Press the On button to turn on the product.

Cause: The product was turned off.
If this did not solve the issue, try the next solution.

Solution 2: Make sure that the original is placed correctly on the glass

Solution: Place your original with the side you want to copy or scan face down on
the left front corner of the glass.

Cause: The original was placed incorrectly on the glass.
If this did not solve the issue, try the next solution.

Solution 3: Wait for the product to finish other tasks

Solution: Check the On light. If it is blinking, the product is busy.

If the product is performing another task such as printing or scanning, your copy job
will be delayed until the product completes the current task.

Cause: The product was busy with another task.
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If this did not solve the issue, try the next solution.

Solution 4: Make sure the paper loaded is recognized by the product

Solution: Do not use the product to copy onto envelopes or other papers the
product does not support.

Related topics
Recommended papers for printing and copying

Cause: The product did not recognize the inserted paper type.
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If this did not solve the issue, try the next solution.

Solution 5: Check for a paper jam
Solution: Clear the paper jam.
For more information, see:

Clear paper jams
Cause: The product had a paper jam.

Parts of the original do not appear or are cut off

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

+ Solution 1: Place the original correctly on the glass

» Solution 2: Clean the scanner glass

Solution 1: Place the original correctly on the glass

Solution: Place your original with the side you want to copy or scan face down on
the left front corner of the glass.

Cause: The original was placed incorrectly on the glass.
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If this did not solve the issue, try the next solution.

Solution 2: Clean the scanner glass
Solution: Clean the scanner glass and make sure that there are no foreign
materials adhering to it.
For more information, see Clean the glass.

Cause: The scanner glass was dirty, causing the product to include an area in the
copy that was larger than the document.
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The printout appears enlarged on the page

Solution: Ensure that your Copy settings are chosen correctly. If the problem
persists, debris might be stuck on the glass or on the back of the document lid. This
can cause the product to detect only a portion of the image. Turn off the product,
unplug the power cord, and use a soft cloth to wipe the glass and the back of the
document lid.

For more information, see:
» Clean the lid backing

+ Clean the glass
Cause: The product detected only a portion of the image due to dust or debris on
the glass.

The printout is blank
Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
+ Solution 1: Place the original correctly on the glass
« Solution 2: Check the ink levels in the print cartridges

Solution 1: Place the original correctly on the glass

Solution: Place your original with the side you want to copy or scan face down on
the left front corner of the glass.
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Cause: The original was placed incorrectly on the glass.
If this did not solve the issue, try the next solution.

Solution 2: Check the ink levels in the print cartridges
Solution: Check the estimated ink levels remaining in the print cartridges.

BY NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the print cartridges until print quality becomes unacceptable.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.

For more information on print cartridges, see Print cartridge froubleshooting.

Cause: The print cartridges needed to be cleaned or there was insufficient ink.

A borderless copy has white space around the edges

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

« Solution 1: Resize the image

» Solution 2: Use photo paper

Solution 1: Resize the image

Solution: When you make a borderless copy of a very small original, the product
enlarges the original up to a maximum percentage. This might leave white space
around the edges. (The maximum percentage varies by model.)

Depending on the size of the borderless copy you are trying to make, the minimum
size of the original varies. For example, you cannot enlarge a passport photo to create
a letter-size borderless copy.

If you want to make a borderless copy of a very small original, scan the original into
the computer, resize the image, and then print a borderless copy of the enlarged
image.

Cause: You were trying to make a borderless copy of a very small original.
If this did not solve the issue, try the next solution.

Solution 2: Use photo paper
Solution: Use photo paper with a tear-off tab to make borderless copies.
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Cause: You were trying to make a borderless copy without using photo paper.

Scan troubleshooting

Use this section to solve these scan problems:

* Scan halts

* Scan fails

* Scanned image is blank

» Scanned image is incorrectly cropped

» Scanned image has incorrect page layout

» Text format is incorrect

* Scanned image shows dotted lines instead of text
» Textis incorrect or missing
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Scan halts
Solution: Turn off the computer and then turn it back on.
If this does not work, try changing the scan to a lower resolution in the software.
Cause: The computer system resources may have been low.

Scan fails

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Make sure your computer is turned on

» Solution 2: Make sure your computer is connected to the product by a USB cable

*  Solution 3: Make sure the HP Photosmart Software is installed on your computer

» Solution 4: Make sure the HP Photosmart Software is running on your computer

» Solution 5: Make sure you have sufficient computer memory

Solution 1: Make sure your computer is turned on
Solution: Turn on your computer.
Cause: The computer was not turned on.
If this did not solve the issue, try the next solution.

Solution 2: Make sure your computer is connected to the product by a USB cable
Solution: Connect your computer to the product with a standard USB cable.
For more information, see the Setup Guide.
Cause: Your computer was not connected to the product by a USB cable.
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If this did not solve the issue, try the next solution.

Solution 3: Make sure the HP Photosmart Software is installed on your computer
Solution: Insert the product installation CD and install the software.
For more information, see the Setup Guide.
Cause: The HP Photosmart Software was not installed on your computer.
If this did not solve the issue, try the next solution.

Solution 4: Make sure the HP Photosmart Software is running on your computer

Solution: Open the software you installed with the product and try scanning again.

BY NOTE: To check to see whether the software is running, right-click on the HP
Digital Imaging Monitor icon in the system tray at the far right of the Windows
taskbar. Pick a device in the list, and then click Display Status.

Cause: The HP Photosmart Software was not running on your computer.
If this did not solve the issue, try the next solution.

Solution 5: Make sure you have sufficient computer memory

Solution: Close all applications that are not in use. This includes applications that
run in the background, such as screen savers and virus checkers. If you turn off your
virus checker, remember to turn it back on after you finish your scan.
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If this problem occurs frequently, or if you encounter memory problems while using
other applications, you might need to add more memory to your computer. See the
user guide that came with your computer for more information.

Cause: Too many applications were running on your computer. These applications
occupied your computer memory.

Scanned image is blank
Solution: Load your original print side down on the right front corner of the glass.
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Cause: The original was placed incorrectly on the glass.

Scanned image is incorrectly cropped

Solution: The autocropping feature in the software crops anything that is not part
of the main image. Sometimes this might not be what you want. In that case, turn off
autocropping in the software and crop the scanned image manually, or not at all.

Cause: The software was set to automatically crop scanned pictures.

Scanned image has incorrect page layout
Solution: Turn off autocropping in the software to retain the page layout.
Cause: The automatic cropping feature in the software was changing the page
layout.

Text format is incorrect
Solution: Some applications cannot handle framed text formatting. Framed text is
one of the scan document settings in the software. It maintains complex layouts, such
as multiple columns from a newsletter, by putting the text in different frames (boxes)
in the destination application. In the software, select the correct format so that the
scanned text layout and formatting are retained.

Cause: The scan document settings were incorrect.
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Scanned image shows dotted lines instead of text
Solution: Make a black-and-white copy of the original and then scan the copy.

Cause: If you used the Text image type to scan text that you plan to edit, the
scanner might not recognize color text. The Text image type scans at 300 x 300 dpi,
in black and white.

If you are scanning an original that has graphics or artwork surrounding the text, the
scanner might not recognize the text.

Text is incorrect or missing

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Make sure that the brightness is set appropriately in the software

+ Solution 2: Make sure that the glass and the back of the document lid are clean

+ Solution 3: Make sure that the scan document settings are set to the correct optical
character recognition (OCR) language

Solution 1: Make sure that the brightness is set appropriately in the software
Solution: Adjust the brightness in the software, and then rescan the original.

To adjust the brightness

1. In the HP Scanning window, click Lighten/Darken in the Basic menu or the
Tools panel.

2. Adjust the brightness indicators.
Cause: The brightness was not set correctly in the software.
If this did not solve the issue, try the next solution.

Solution 2: Make sure that the glass and the back of the document lid are clean

Solution: Turn off the product, unplug the power cord, and use a soft cloth to wipe
the glass and the back of the document lid.

For more information, see:

* Clean the lid backing

» Clean the glass

Cause: The glass and the back of the document lid were not clean.

If this did not solve the issue, try the next solution.

Solution 3: Make sure that the scan document settings are set to the correct optical
character recognition (OCR) language

Solution: Select the correct OCR language in the software.
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B NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install
the OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

See the documentation that came with Readiris, or whichever OCR software you use,
for information on how to select the OCR language.

Cause: The scan document settings were not set to the correct optical character
recognition (OCR) language.
The OCR language tells the software how to interpret the characters it sees in the

original image. If the OCR language does not match the language in the original, the
scanned text might be incomprehensible.
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Errors

If the product has an error, the lights on the product might flash, or an error message
might appear on your computer screen.

This section contains the following topics:

Flashing lights
Product messages

File messages
General user messages

Paper messages
Power and connection messages
Print cartridge messages

Flashing lights

The lights on the HP All-in-One flash in special sequences to inform you about various
error conditions. Refer to the following table for information on solving your error condition
based on which lights are on or blinking on the HP All-in-One.

On light Paper Check Paper Descriptio | Solution
light Print Type n
Cartridge | lights
light
Off Off Off Both off | The HP All- | Press the On button to turn the
in-One is HP All-in-One on.
turned off.
Blinking Off Off 10n, The HP All- | Wait for the HP All-in-One to
1 0f in-One is finish.
processing
a job, such
as print,
scan, copy,
or
alignment.
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(continued)

On light Paper Check Paper Descriptio | Solution
light Print Type n
Cartridge | lights
light
Blink faster | Off Off 10n, The HP All- | Wait for the HP All-in-One to
for 3 1 0Off in-One is finish.
seconds busy.
= and then
% On
o Blink for 20 | Off Off 10n, Scan was Make sure the computer is
3 seconds 1 0Off pressed, turned on, the HP All-in-One
S and then and there software is installed, and the
= On was no computer is connected to the
response HP All-in-One with a USB
from the cable.
computer.
On Blinking Off 10On, The HP All- | Load paper and press any
1 Off in-One is button.
out of
paper.
The HP All- | Clear the paper jam, and
in-One has | press any button.
a paper
jam.
Paper-size | Change the paper in the tray
setting does | or the size setting in the
not match software.
the paper
size
detected in
the input
tray.
On Off Blinking 10On, Print Raise the door to close it.
1 Off cartridge
door is
open.
The print Install or remove and reinsert
cartridges print cartridges.
are missing
or not
seated
correctly.
The tape Remove print cartridge,
was not remove tape, and reinsert
removed print cartridge.
from the
print
cartridge.
The print The print cartridge might not
cartridge is | be supported for use in the
not HP All-in-One. See the Order
intended for | Supplies chapter in the User
use in this Guide.
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(continued)

On light Paper Check Paper Descriptio | Solution
light Print Type n

Cartridge | lights

light
HP All-in-
One.
The print 1. Remove the black print
cartridge cartridge.
might be 2. Close the print cartridge
defective. door.

3. Check the On light.

« If the On light blinks,
replace the tri-color
print cartridge.

e Ifthe Onlightremains
steadily lit, replace
the black print
cartridge.

On Blinking Blinking 10n, The print Open the print cartridge door,
1 0f carriage is | and check that the carriage is
stalled. not blocked.
On Blinking Blinking Both The control | 1. Turn the HP All-in-One
blinking | panel off.
overlayis | 2. Attach the control panel
not overlay using the
attached or instructions in the Setup
is not Guide.
attached | 3 3y the HP All-in-One
properly. back on.
Blinking Blinking Blinking Both off | Scanner Turn the HP All-in-One off,
failure then on again.
If the problem persists,
contact HP customer support.
Blinking Blinking Blinking Both The HP All- | 1. Turn the HP All-in-One
blinking | in-One has off.

a fatal error.

2. Unplug the power cord.

3. Wait a minute, then plug
the power cord back in.

4. Turn the HP All-in-One
back on.

If the problem persists,

contact HP Support.

Product messages

The following is a list of product-related error messages:

» Door open
* Firmware revision mismatch

* Mechanism error

e Memory is full
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* Scan errors

* Unable to print

*  Product might not be correctly installed

*  Product was not found

*  Product could not find available scan destinations

» Required software component was not found or was incorrectly installed
» Error occurred while communicating with the product

Door open

Solution: Close the print cartridge door.
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Cause: The print cartridge door was open.

Firmware revision mismatch

Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Cause: The revision number of the product firmware does not match the revision
number of the software.

Mechanism error

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Check for a paper jam

« Solution 2: Make sure the print carriage is not blocked

Solution 1: Check for a paper jam
Solution: Clear the paper jam.
For more information, see:
Clear paper jams
Cause: The product had a paper jam.
If this did not solve the issue, try the next solution.
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Solution 2: Make sure the print carriage is not blocked

Solution: Turn off the product, open the print cartridge door, and remove any
objects that are blocking the print carriage (including any packing materials), and then
turn on the product.
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For more information, see:

The print carriage is stalled

Cause: The print carriage was blocked.

Memory is full
Solution: Try making fewer copies at a time.
Cause: The document you are copying has exceeded the memory of the product.

Scan errors

Review this section if you receive an error such as one of the following:

« An error occurred communicating with the scanning device. Please ensure that the
scanning device is connected properly and try again.

« The scanning device could not be initialized.

» The scanning device could not be found.

* Aninternal error has occurred.

«  The computer cannot communicate with the scanning device.

Br NOTE: Before starting to troubleshoot, make a copy to verify that the hardware is
functioning correctly. If you cannot make a copy, see Hardware setup
troubleshooting for more troubleshooting information.

Try each of the following solutions separately. After completing the steps for each
solution, try to scan again. If the product still does not work, then go to the next solution.
* Solution 1: Uninstall and reinstall the software

» Solution 2: Refresh the Windows Device Manager

» Solution 3: Check the Digital Imaging Monitor

» Solution 4: Check the status of the product

* Solution 5: Check the power supply

» Solution 6: Check the USB cable connection
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* Solution 7: Scan with Windows Image Acquisition (WIA)
» Solution 8: Disable the Lexbces service

» Solution 9: Run the Scan Diagnostic utility

* Solution 10: Install a patch

* Solution 11: Check the USB chipset and controller

» Solution 12: Uninstall the software and reset the product

Solution 1: Uninstall and reinstall the software

Solution: Verify that the software was installed correctly. Open the HP Solution
Center and verify that all the icons and buttons are present.
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If the appropriate icons and buttons for your product (such as Make Copies) do not
appear, your installation might not be complete, and you might need to uninstall and
then reinstall the software. Do not simply delete the application files from your hard

drive. Make sure to remove them properly using the uninstall utility provided with the
software.

To uninstall from a Windows computer

BY NOTE: Use this method if Uninstall is not available in the Windows Start menu
(click Programs or All Programs, HP, Deskjet F2200 All-In-One series,
Uninstall).

1. Open the Windows control panel and double-click Add or Remove Programs.

B NOTE: The procedure to open the control panel varies by operating system.
If you are not sure how to do this, see the Windows Help.

2. Select HP Deskjet All-In-One Driver Software, and then click Change/
Remove.
Follow the onscreen instructions.

3. Disconnect the product from your computer.

4. Restart your computer.

Bf NOTE: Itis important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.

5. Insert the product CD-ROM into your computer’s CD-ROM drive and then start
the Setup program.

6. Follow the onscreen instructions and the instructions provided in the Setup Guide
that came with the product.

After you have reinstalled the software, try to scan again.
Cause: The software installation was not complete.
If this did not solve the issue, try the next solution.
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Solution 2: Refresh the Windows Device Manager
Solution: Refresh the Windows Device Manager.

To refresh the Windows Device Manager

1. On the Windows taskbar, click Start, right-click My Computer, and then click
Properties.

2. Click the Hardware tab, and then click Device Manager.

Double-click Universal Serial Bus Controllers.

4. Click USB Composite Device, click Action, and then click Uninstall.
If a screen appears to confirm the deletion, confirm the deletion.

5. Disconnect the USB cable from the product.

6. Wait a few seconds, and then reconnect the cable.

This should restart the Windows device detection (Plug and Play). A New
Hardware found screen might appear.

7. Click Next through all of the screens that appear in the Wizard to install the USB
Composite Device.

8. Click Finish to finish the installation.

9. Try to scan again.

10. If these steps do not resolve the problem, try using a different USB cable to
connect the product to the computer.

w
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Cause: Communication problems between the product and the USB controller
caused this error to occur. This might be caused by an incomplete installation, a USB
cable longer than 3 meters (9.8 feet) in length, or a defective USB cable.

If this did not solve the issue, try the next solution.

Errors 139



Chapter 12

Solution 3: Check the Digital Imaging Monitor

Solution: Verify that the Digital Imaging Monitor is running.

To check that the Digital Imaging Monitor is running

1. Look for the Digital Imaging Monitor icon in the system tray at the lower right
side of the screen, near the time.
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2. If the Digital Imaging Monitor icon is not present, restart the computer.
3. After the computer restarts, try to scan again.

Cause: The Digital Imaging Monitor was not running.
If this did not solve the issue, try the next solution.

Solution 4: Check the status of the product
Solution: Check the status of the product in the HP Solution Center.

To check the status of the product
1. On the Windows taskbar, click Start, Programs or All Programs, HP, HP
Solution Center.

2. Verify that the product is listed in the Select Device area or that the appropriate
tab is selected.

3. Click Status.
If the product is working properly, a message appears indicating your product is
ready.

4. If you receive a Disconnected error message, then check whether there is
another instance or another tab for the product with a copy number included, such
as HP Deskjet F2200 All-in-One series 2.
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5. Select the second instance of the product and repeat steps 2 through 4.
6. Try to scan again.

Cause: There might have been two instances of the product connected to the
HP Solution Center.

If this did not solve the issue, try the next solution.

Solution 5: Check the power supply
Solution: Check the power supply.
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To check the power supply
1. Make sure the power cord is firmly connected to both the product and the power
adaptor. Plug the power cord into a power outlet, surge protector, or power strip.

1 | Power connection

2 | Power cord and adaptor

Make sure the product is turned on.

If the product is not receiving electrical power, connect it to another power outlet.
Turn off the product and reset it by disconnecting the power cord.

Wait 5 seconds, and plug in the power cord.

Turn on the product.

Try to scan again.

Cause: The product was not properly connected to a power supply or needed to be
reset.

If this did not solve the issue, try the next solution.

NoapowbN
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Solution 6: Check the USB cable connection

Solution: Check USB connection between the product and the computer.

To check the USB connection

1. Verify that the USB cable is securely plugged into the USB port on the back of
the product.

2. Make sure the other end of the USB cable is plugged into a USB port on your
computer.
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3. Try to scan again.

If the scan fails, continue to the next step.

4. Do one of the following, depending upon how the product is connected to the
computer:

» Ifthe USB cable is connected to a USB hub, try unplugging and replugging
the USB cable into the hub. If that does not work, try turning off the hub and
then turning it on again. Finally, try disconnecting the cable from the hub and
connecting it directly to the computer.

» Ifthe USB cable is connected to a docking station for a laptop, disconnect the
cable from the docking station and connect it directly to the computer.

« If the USB cable is directly connected to the computer, try plugging it into
another USB port on the computer.

5. If there are other USB devices connected to the computer, disconnect the other
devices, except for the keyboard and the mouse.
6. Check the USB cable to make sure it is functioning properly.

E¥ NOTE: If you are using an older cable, it might not be working properly. Try
connecting it to another product to see if the USB cable works. If you
experience problems, the USB cable might need to be replaced. Also verify
that the cable does not exceed 3 meters (9.8 feet) in length.
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7. If another USB cable is available, try using that one instead.
8. Restart the computer.
9. After the computer restarts, try to scan again.

Cause: The product was not properly connected to the computer.
If this did not solve the issue, try the next solution.

Solution 7: Scan with Windows Image Acquisition (WIA)

Solution: Try scanning with Windows Image Acquisition (WIA) instead of the
HP Solution Center.

(=2
c
=
o
o
<
0
o
2
3
2
[

To scan using WIA

1. Make sure the product is turned on.

2. Verify that the USB cable is securely plugged into the USB port on the back of
the product.
The USB icon on the cable faces up when the cable is properly connected.

3. Make sure the other end of the USB cable is plugged into a USB port on your
computer.

4. On the Windows taskbar, click Start, click Programs or All Programs, and then
click Accessories.

Click Imaging.

From the Imaging application, click File and then click Select Device.

Select the product from the TWAIN source list.

Click File, and then click Scan New.

Imaging for Windows will scan from the product using TWAIN software instead of
the HP Solution Center.

Cause: If you could scan using WIA, this indicates that there was a problem with
the HP Solution Center. You can continue to use WIA to scan, or try the next solution.

©No o
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If you could not scan using WIA, try the next solution.

Solution 8: Disable the Lexbces service
Solution: Check if the Lexbces service is started, and disable it.

If a Lexmark or Dell all-in-one device is connected with a USB cable to a computer
where product is installed, the HP software might not scan because the Lexbces
service is running.

BY NOTE: This solution only applies if you have a Lexmark or Dell all-in-one. If you
do not, try the next solution.
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To check for and disable the service

1. Log into Windows as an Administrator.

2. Press the Ctrl + Alt + Delete to open the Task Manager.

3. Click the Processes tab.

4. If the Lexbceserver service is listed in the Image Name list, disable it.

To disable the service

a. On the Windows taskbar, click Start, right-click My Computer, and then click
Manage.

The Computer Management appears.

Double-click Services and Applications, and then double-click Services.
In the right pane, right-click Lexbceserver, and then click Properties.

On the General tab, in the Service status area, click Stop.

From the Startup type drop-down menu, select Disabled, and then click
OK.

f. Click OK to close the dialog box.
5. Back up the Registry.

® oo

To back up the Registry
a. On the Windows taskbar, click Start.
b. Depending on your operating system, do one of the following:
+  Windows Vista: In Start Search, type regedit, and then press Enter.
When the User Account Control dialog box appears, click Continue.

* Windows XP: Click Run. When the Run dialog box appears, type
regedit, and then press Enter.

+  Windows 2000: Click Registry, and then click Export Registry
The Registry Editor appears.

c. Inthe Registry Editor, select My Computer.

d. With My Computer highlighted, click File, and then click Export.

e. Browse to a storage location that is easy for you to remember; for example:
My Documents or Desktop.

f. Inthe Export Range area, select All.
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6. Edi

To edit the Registry

a.

d.

t the registry.

Enter a filename for the backed up Registry.
HP suggests naming the file with the current date; for example: Registry
Backup 04_01_07.

Click Save to save the Registry.

Select the HKEY_LOCAL_MACHINE\System\CurrentControlSet
\Services\Spooler Registry key.
Details of the Registry key appears on the pane to the right.

Check the DependOnService data string (in the pane on the right) to see if
lexbces is listed in the Data column.

If the Data column contains lexbces, right-click DependOnService and

select Modify.

Do one of the following:

» If you see only lexbces, but not RPCSS, delete lexbces and enter
RPCSS.

» If you see both lexbces and RPCSS, delete only lexbces and keep
RPCSS.

Click OK.
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7. Restart the computer, and then try to scan again.
If you can scan successfully, then proceed with the next step to restart the
Lexbcserver service.

NOTE: Restarting the service enables the normal functionality of the
Lexmark or Dell devices without affecting HP software.

8. Restart the Lexbcserver service.

To
a.

®ao0rvT

f.

restart the service

On the Windows taskbar, click Start, right-click My Computer, and then click
Manage.

The Computer Management screen appears.

Double-click Services and Applications, and then double-click Services.
In the right pane, right-click Lexbceserver, and then click Properties.

On the General tab, in the Service status area, click Start.

From the Startup type drop-down menu, select Automatic, and then click
OK.

Click OK to close the dialog box.

Cause: The Lexbceserver service installed by a Lexmark printer, Lexmark all-in-
one, or Dell all-in-one, caused a scan communication error.

If this did not solve the issue, try the next solution.
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Solution 9: Run the Scan Diagnostic utility

Solution: Download and run the Scan Diagnostic utility to find and correct
problems with your product.

To download and run the Scan Diagnostic utility

1. Go to: www.hp.com and click Software and driver downloads.

2. Select Download drivers and software (and firmware).

3. Type your product name and model number in the field provided, and then press
Enter.

4. Select the operating system of your computer where the HP software is installed.

Go to the Utility section and download the HP Scan diagnostic utility.

6. Trytoscan.
If an error condition is identified with any of the HP software components, a red
X is displayed next to the component. If there is no error condition, a green check
mark is displayed next to the component. The utility is equipped with a Fix button
to correct the error conditions.
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Cause: There was a problem with the connections between the product and the
computer.

If this did not solve the issue, try the next solution.

Solution 10: Install a patch

Solution: Download and install the unexpected internal error and
communications failure patch.

This patch resolves the An unexpected internal error has occurred error and other
communication failures with the product.

To install the patch

1. Go to: www.hp.com and click Software and driver downloads.

2. Select Download drivers and software (and firmware).

3. Select the operating system of your computer where the HP software is installed.
4

Go to the Patch section and download the HP Image zone/photo and imaging
unexpected internal error and communications failure patch.

5. Double-click the patch to install it on the computer.
6. Try to scan.

Cause: You needed to install the unexpected internal error and
communications failure patch.

If this did not solve the issue, try the next solution.

Solution 11: Check the USB chipset and controller
Solution: Check the USB chipset and controller.

Scan communication errors can occur because of compatibility issues with USB
chipsets installed on the computer. This can be caused by a mismatch in the
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handshake timing between HP device chipset and certain types of USB chipsets on
the computer.

To check the USB chipset and controller
1.

d

On the Windows taskbar, click Start, right-click My Computer, and then click
Properties.

Click the Hardware tab, and then click Device Manager.

Open Universal Serial Bus Controllers by clicking the plus sign (+) next to it.
Check if you have one of the following chipsets listed:

+ SIS 7001 USB host controller

* ALl chipsets

* NEC universal host controllers

* Intel 82801 AA, Intel 82801BA/BAM
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Bf NOTE: This is not a comprehensive list. If you are experiencing
communication issues while trying to scan, follow the steps below to resolve
the issue.

Disconnect all USB devices (printers, scanners, cameras, etc.) from the
computer, except the mouse or keyboard.

Reconnect the USB cable to the USB port on the back of the product.
Reconnect the other end of the USB cable to a USB port on your computer.
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8. Make sure the power cord is firmly connected to both the product and the power
adaptor. Plug the power cord into a power outlet, surge protector or power strip.
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N

Power connection

2 | Power cord and adaptor

9. Turn on the product.

10. Print a self-test report to test the basic standalone functionality of the product.
See the following procedure for more information about printing a self-test report.

11. Try to scan.

If the scan is successful, other USB devices connected to the computer might be
causing the problem.

12. If the scan is successful, then connect one USB device at a time to the computer.

13. Test the scanning functionality after each connection, until you identify which
piece of equipment is causing the problem.

14. If the product fails to scan. Or, does not establish communication with the
computer along with any of the USB devices plugged in, then connect a powered
USB hub between the product and the computer.

This might help to establish, or to maintain, communication between the computer
and the product. See the following section for more information about USB hubs.

To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Start Copy Color button.

The product prints a self-test report, which might indicate the source of the printing
problem. A sample of the ink test area of the report is shown below.
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3. Make sure the test patterns show a complete grid and the thick color lines are

complete.

* If more than a few lines in a pattern are broken, this might indicate a problem
with the nozzles. You might need to clean the print cartridges.

« Ifthe black line is missing, faded, streaked, or shows lines, this might indicate
a problem with the black print cartridge in the right slot.

« Ifany of the color lines are missing, faded, streaked, or show lines, this might
indicate a problem with the tri-color print cartridge in the left slot.

More information about using a USB hub

» Verify that the USB hub is a powered hub and the power adapter is plugged in.
Some powered hubs do not include the power adapter as a standard item.

*  The hub must be plugged into a power source.

+ Some hubs cannot handle more than four full-power USB devices. You can
connect a maximum of five hubs to the system.

+ If the product has trouble with a hub when the hubs are connected together, or
there are more than four devices on the hub, connect the product to the hub that
is directly connected to the computer (unless there are known issues).

Cause: There was a compatibility issue with USB chipsets installed on the

computer.

If this did not solve the issue, try the next solution.
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Solution 12: Uninstall the software and reset the product
Solution: Uninstall the software completely, and then reinstall it.

To uninstall the software and reset the product
1. Disconnect and reset the product.

To disconnect and reset the product

Make sure the product is turned on.

Press the On button to turn off the product.

Disconnect the power cord from the back of the product.
Reconnect the power cord to the back of the product.
Press the On to turn on the product.

2. Unlnstall the software completely.

@ a0 o

BY NOTE: ltis important that you follow the uninstall procedure carefully to
ensure you have removed the software completely from the computer, before
reinstalling it.
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To uninstall the software completely

a. On the Windows taskbar, click Start, Settings, Control Panel, (or just
Control Panel).

Double-click Add/Remove Programs (or click Uninstall a program).
Remove all the items that are related to the HP scanning software.

/\ CAUTION: If the computer is manufactured by HP or Compagq, do not
remove any applications other than those listed below.

» HP Imaging device functions
* HP Document Viewer

* HP Photosmart Essential

* HP Image Zone

+ HP Photo and imaging gallery

» HP Photosmart, Officejet, Deskjet, (with product name and software
version number)

* HP Software update

* HP Share to web

« HP Solution Center

* HP Director

+ HP Memories Disk Greeting Card Creator 32

d. GotoC:\Program Files\HP or C:\Program Files\Hewlett-
Packard (for some older products) and delete the Digital Imaging
folder.

e. Goto C:\WINDOWS and rename the twain_32 folderto twain 32 old.
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3. Turn off programs that run in the background.

B NOTE: When the computer is turned on, a software group called the
Terminate and Stay Resident (TSR) programs automatically loads. These
programs activate some of the computer utilities, such as the anti-virus
software, but are not required for the computer to function. Occasionally,
TSR's prevent the HP software from loading so that it does not install properly.
In Windows Vista, Windows XP, and Windows 2000, use the MSCONFIG
utility to prevent TSR programs and services from starting up.

To turn off programs that run in the background
a. On the Windows taskbar, click Start.
b. Depending on your operating system, do one of the following:
* In Windows Vista: In Start Search, type MSCONFIG, and then press
Enter.
When the User Account Control dialog box appears, click Continue.
* In Windows XP and Windows 2000: Click Run. When the Run dialog box
appears, type MSCONFIG, and then press Enter.
The MSCONFIG utility application appears.
c. Click the General tab.
d. Click Selective Startup.
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If there is a check mark next to Load Startup Items, click the check mark to
remove it.

Click the Services tab, and select the Hide All Microsoft Services box.
Click Disable all.

Click Apply, and then click Close.

Bf NOTE: Ifyou receive a message stating Access is denied while making
changes, click OK and continue. The message will not prevent you from
making the changes.

Click Restart to apply the changes to the computer during the next restart.
After the computer restarts, the You’ve used system configuration utility
to make changes to the way windows starts message appears.

Click the check box next to Do not show this message again.
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Run the Disk Cleanup utility to delete temporary files and folders.

To run the Disk Cleanup utility

a.

b.

On the Windows taskbar, click Start, click Programs or All Programs, and

then click Accessories.

Click System Tools, and then click Disk Cleanup.

The Disk Cleanup analyzes the hard drive and then presents a report with a
list of components to delete.

Select the appropriate check boxes to remove the unnecessary components.

More information about the Disk Cleanup utility

The Disk Cleanup utility frees hard disk space on your computer by doing the
following:

* Deleting temporary Internet files

* Deleting downloaded program files

* Emptying the Recycle Bin

* Deleting files from your temporary folder

» Deleting files created by other Windows tools

* Removing optional Windows components that you do not use

d. After selecting the components to remove, click OK.
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152

6.

Install the software.

To install the software
a. Insert software CD into the CD-ROM drive of the computer.
The software installation will start automatically.

Bf NOTE: If the installation does not run automatically, from the Windows
Start menu, click Start Search (or Run). In the Start Search (or Run
dialog box), type d: \ setup . exe, and then press Enter. (If your CD-ROM
drive is not assigned to drive letter D, enter the appropriate drive letter.)

b. Follow the prompts on the computer screen to install the software.
Try to scan.

Cause: The software needed to be completely uninstalled and reinstalled.

Unable to print

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

Solution 1: Print a self-test report

Solution 2: Clear the print queue

Solution 3: Disconnect and reconnect the USB cable

Solution 4: Verify the driver configuration

Solution 5: Check if the printer is paused or offline

Solution 6: Clear the print gueue manually

Solution 7: Restart the print spooler

Solution 8: Check the software application

Solution 1: Print a self-test report

Solution: Printa self-test report to see if the product can print and is communicating
with the computer.

To print a self-test report
Load letter or A4 unused plain white paper into the input tray.
Press and hold the Cancel button and then press the Start Copy Color button.

The product prints a self-test report, which might indicate the source of the printing
problem. A sample of the ink test area of the report is shown below.

1.
2,
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3. Make sure the test patterns show a complete grid and the thick color lines are

complete.

* If more than a few lines in a pattern are broken, this might indicate a problem
with the nozzles. You might need to clean the print cartridges.

« Ifthe black line is missing, faded, streaked, or shows lines, this might indicate
a problem with the black print cartridge in the right slot.

« Ifany of the color lines are missing, faded, streaked, or show lines, this might
indicate a problem with the tri-color print cartridge in the left slot.

If the self-test report fails to print, make sure you set up the product properly. See the
Setup Guide that came with the product for information about setting it up.
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Cause: The product was not set up properly.
If this did not solve the issue, try the next solution.

Solution 2: Clear the print queue
Solution: Restart your computer to clear the print queue.

To clear the print queue
1. Restart your computer.
2. After the computer has restarted, check the print queue.
a. Depending upon your operating system, do one of the following:
¢ Windows Vista: On the Windows taskbar, click Start, click Control
Panel, and then click Printers.
*  Windows XP: On the Windows taskbar, click Start, click Control Panel,
and then click Printers and Faxes.
*  Windows 2000: On the Windows taskbar, click Start, point to Settings,
and then click Printers.
b. Double-click the icon for your product to open the print queue.
If there are no print jobs pending, the issue might have been resolved.
3. Try to print again.
Cause: The computer needed to be restarted to clear the print queue.

If this did not solve the issue, try the next solution.

Solution 3: Disconnect and reconnect the USB cable

Solution: Disconnect the USB cable from the computer and product, and then
reconnect it.

To disconnect and reconnect the USB cable

1. Disconnect the USB cable from the product.

2. Disconnect the USB cable from the computer.

3. Leave the USB cable disconnected for 5-6 seconds.
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4. Reconnect the USB cable to the product and the computer.
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After reconnecting the USB cable, the product should start printing the jobs in
queue.

B NOTE: Ifyou are connecting the product through a USB hub, make sure the
hub is turned on. If the hub is on, try connecting directly to your computer.

5. If the product does not start printing automatically, start another print job.
Cause: The USB cable needed to be disconnected.

If this did not solve the issue, try the next solution.

Solution 4: Verify the driver configuration

Solution: Check to make sure the product is set as the default printer and it is using
the correct printer driver.

To verify that the product is set as the default printer
1. Depending upon your operating system, do one of the following:
*  Windows Vista: On the Windows taskbar, click Start, click Control Panel, and
then click Printers.
*«  Windows XP: On the Windows taskbar, click Start, click Control Panel, and
then click Printers and Faxes.
*  Windows 2000: On the Windows taskbar, click Start, point to Settings, and
then click Printers.
2. Make sure the correct product is set as the default printer.
The default printer has a check mark in a black circle next to it.
3. Ifthewrong product is set as the default printer, right-click the correct product and
select Set as Default.
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To verify the print driver
1.

8.

Depending upon your operating system, do one of the following:

*  Windows Vista: On the Windows taskbar, click Start, click Control Panel, and
then click Printers.

*  Windows XP: On the Windows taskbar, click Start, click Control Panel, and
then click Printers and Faxes.

*  Windows 2000: On the Windows taskbar, click Start, point to Settings, and
then click Printers.

Right-click the icon next to the product, and select Properties.

Click the Ports tab to verify that the product is using the correct port.

The port that the product is using is highlighted and has a check mark next to it.

The product should be set to use a DOT4 or the USB0OOX (where X is replaced

by a number) port.

If the product is using the wrong port, click the correct port to select it.

The port that the product is now using is highlighted and has a check mark next

to it.

Click the Advanced tab.

Check the driver listed in the Driver drop-down menu to verify that the product is

using the correct driver.

The name of your product should be listed as the driver.

If the wrong driver is selected, select the correct driver from the Driver drop-down

menu.

Click OK to save your changes.
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Cause: If there was more than one product configured on the same computer, the
product in use was not be set as the default printer, or the wrong driver might have
been configured.

If this did not solve the issue, try the next solution.

Solution 5: Check if the printer is paused or offline

Solution: Check to make sure the product is not paused or offline.

To check if the printer is paused or offline

1.

Depending upon your operating system, do one of the following:

*  Windows Vista: On the Windows taskbar, click Start, click Control Panel, and
then click Printers.

*  Windows XP: On the Windows taskbar, click Start, click Control Panel, and
then click Printers and Faxes.

*  Windows 2000: On the Windows taskbar, click Start, point to Settings, and
then click Printers

2. Double-click the icon for your product to open the print queue.
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3. On the Printer menu, make sure there are no check marks next to Pause
Printing or Use Printer Offline.
On the Printer menu, make sure there are no check marks next to Pause
Printing or Use Printer Offline. If a check mark is present on either option, click
the menu option to remove it. If the menu has the Use Printer Online option,
select that option to put a check mark next to it.

4. If you made any changes, try to print again.
Cause: The product was paused or offline.
If this did not solve the issue, try the next solution.
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Solution 6: Clear the print queue manually
Solution: Manually clear the print queue.

To clear the print queue manually
1. Depending upon your operating system, do one of the following:

*  Windows Vista: On the Windows taskbar, click Start, click Control Panel, and
then click Printers.

*  Windows XP: On the Windows taskbar, click Start, click Control Panel, and
then click Printers and Faxes.

*  Windows 2000: On the Windows taskbar, click Start, point to Settings, and
then click Printers.

2. Double-click the icon for your product to open the print queue.

3. On the Printer menu, click Cancel all documents or Purge Print Document,
and then click Yes to confirm.

4. If there are still documents in the queue, restart the computer and try printing
again after the computer has restarted.

5. Check the print queue again to make sure it is clear, and then try to print again.

If the print queue is not clear, or if it is clear but jobs are still failing to print, proceed
to the next solution.

Cause: The print queue needed to be manually cleared.
If this did not solve the issue, try the next solution.

Solution 7: Restart the print spooler
Solution: Restart the print spooler.

To stop and restart the print spooler
1. On the Windows taskbar, click Start, and then click Control Panel.
2. Double-click Administrative Tools, and then double-click Services.

3. Scroll down the list and click Print Spooler, and then click Stop to stop the
service.

4. Click Start to restart the service, and then click OK.
5. Restart the computer and try printing again after the computer has restarted.
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Cause: The print spooler needed to be restarted.
If this did not solve the issue, try the next solution.

Solution 8: Check the software application
Solution: Verify whether the software application is the problem.

To verify the software application
1. Close the software application and reopen it.
2. Try to print again from the software application.

(=2
c
=
[<}
o
<
0
o
2
=}
e
[

Bf NOTE: The printer might not support printing from a DOS application.
Determine if the software application is Windows-based or DOS-based by
checking the system requirements of the application.

3. Try printing from Notepad to see if the issue is the software application or the
driver.

To print from Notepad
a. On the Windows taskbar, click Start, and then click Programs or All
Programs.
b. Click Accessories, and then click Notepad.
c. Type a few characters of text into Notepad.
d. Click File, and then click Print.
4. If printing is successful from Notepad but not the software application, contact the
manufacturer of that application for support.
Cause: The software application was be failing or could not interface with the print
driver incorrectly.

Product might not be correctly installed

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Reset the product

» Solution 2: Check the power cord and USB cable

» Solution 3: Restart the computer

« Solution 4: Uninstall and reinstall the product

* Solution 5: Uninstall and reinstall the HP Photosmart Software

Solution 1: Reset the product

Solution: Turn off the product and reset it by disconnecting the power cord. Wait
60 seconds, and then plug in the power cord. Turn on the product.

Cause: You needed to reset the product.
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If this did not solve the issue, try the next solution.

Solution 2: Check the power cord and USB cable

Solution: Make sure that the power cord and USB cable are properly attached and
plugged in. Also, make sure that the product is turned on.

To check the power supply

1. Make sure the power cord is firmly connected to both the product and the power
adaptor. Plug the power cord into a power outlet, surge protector, or power strip.
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1 | Power connection

Power cord and adaptor

Power outlet

Make sure the product is turned on.

If the product is not receiving electrical power, connect it to another power outlet.
Turn off the product and reset it by disconnecting the power cord.

Wait 5 seconds, and plug in the power cord.

Turn on the product.

Try to scan again.

No o p®Dd
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To check the USB connection
1.

Verify that the USB cable is securely plugged into the USB port on the back of
the product.

Make sure the other end of the USB cable is plugged into a USB port on your
computer.
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Try to scan again.

If the scan fails, continue to the next step.

Do one of the following, depending upon how the product is connected to the

computer:

+ If the USB cable is connected to a USB hub, try unplugging and replugging
the USB cable into the hub. If that does not work, try turning off the hub and
then turning it on again. Finally, try disconnecting the cable from the hub and
connecting it directly to the computer.

+ Ifthe USB cable is connected to a docking station for a laptop, disconnect the
cable from the docking station and connect it directly to the computer.

« Ifthe USB cable is directly connected to the computer, try plugging it into
another USB port on the computer.

If there are other USB devices connected to the computer, disconnect the other

devices, except for the keyboard and the mouse.

Check the USB cable to make sure it is functioning properly.

Bf NOTE: If you are using an older cable, it might not be working properly. Try
connecting it to another product to see if the USB cable works. If you
experience problems, the USB cable might need to be replaced. Also verify
that the cable does not exceed 3 meters (9.8 feet) in length.

If another USB cable is available, try using that one instead.
Restart the computer.

. After the computer restarts, try to scan again.

Cause: The power cord or USB cable was not attached properly.
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If this did not solve the issue, try the next solution.

Solution 3: Restart the computer
Solution: Restart the computer.

Cause: You might not have restarted the computer after installing the product
software. Or, there might have been another problem with the computer.

If this did not solve the issue, try the next solution.
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Solution 4: Uninstall and reinstall the product

Solution: Uninstall the product from the Printers and Faxes control panel and then
reinstall it.

To uninstall and reinstall the product

1. Disconnect the USB cable between the product and the computer.
2. On the Windows taskbar, click Start, Printers and Faxes.

3. Right-click the product and select Delete.
4

Wait several seconds, and then reconnect the product to the computer with the
USB cable.

5. Follow any onscreen prompts to reinstall the product.
Cause: There might have been a problem when you originally installed the product.
If this did not solve the issue, try the next solution.

Solution 5: Uninstall and reinstall the HP Photosmart Software

Solution: Uninstall the complete HP Photosmart Software from the computer and
then reinstall it using the CD that came with your product.

To uninstall and reinstall the software

1. On the Windows taskbar, click Start, Settings, Control Panel.

2. Double-click Add/Remove Programs.

3. Remove all the items that are related to the HP scanning software.

A message appears on the computer to restart after removing some programs
from the Add/Remove Programs list.

4. Select Click here to restart later.
5. Disconnect the product from your computer and then restart your computer.

Bf NOTE: Itis important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.
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6. Insertthe HP Photosmart CD-ROM into your computer’'s CD-ROM drive and then

7. Follow the onscreen instructions and the instructions provided in the Setup Guide

8. If you are still having trouble scanning, remove the following additional

start the Setup program.

BY NOTE: If the Setup program does not appear, locate the setup.exe file on
the CD-ROM drive and double-click it.

that came with the product.

applications from the Add/Remove Programs list, if they are present.

/\ CAUTION: I[f the computer is manufactured by HP or Compaq, do not
remove any applications other than those listed below.
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* HP Imaging device functions
* HP Document Viewer

* HP Photosmart Essential

+ HP Image Zone

+ HP Photo and imaging gallery

+ HP Photosmart, Officejet, Deskjet, (with product name and software version
number)

* HP Software update

* HP Share to web

* HP Solution Center

* HP Director

*  HP Memories Disk Greeting Card Creator 32

Cause: There might have been a problem when you originally installed the
HP Photosmart Software.

Product was not found

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

Solution 1: Reset the product

Solution 2: Check the power cord and USB cable

Solution 3: Restart the computer

Solution 4: Uninstall and reinstall the product

Solution 5: Uninstall and reinstall the HP Photosmart Software

Solution 1: Reset the product

Solution: Turn off the product and reset it by disconnecting the power cord. Wait
60 seconds, and then plug in the power cord. Turn on the product.

Cause: You needed to reset the product.
If this did not solve the issue, try the next solution.
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Solution 2: Check the power cord and USB cable

Solution: Make sure that the power cord and USB cable are properly attached and
plugged in. Also, make sure that the product is turned on.

To check the power supply

1. Make sure the power cord is firmly connected to both the product and the power
adaptor. Plug the power cord into a power outlet, surge protector, or power strip.
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1 | Power connection

Power cord and adaptor

Power outlet

Make sure the product is turned on.

If the product is not receiving electrical power, connect it to another power outlet.
Turn off the product and reset it by disconnecting the power cord.

Wait 5 seconds, and plug in the power cord.

Turn on the product.

Try to scan again.

Nooak~eNdN
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To check the USB connection
1.

Verify that the USB cable is securely plugged into the USB port on the back of
the product.

Make sure the other end of the USB cable is plugged into a USB port on your
computer.
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Try to scan again.

If the scan fails, continue to the next step.

Do one of the following, depending upon how the product is connected to the

computer:

+ If the USB cable is connected to a USB hub, try unplugging and replugging
the USB cable into the hub. If that does not work, try turning off the hub and
then turning it on again. Finally, try disconnecting the cable from the hub and
connecting it directly to the computer.

+ Ifthe USB cable is connected to a docking station for a laptop, disconnect the
cable from the docking station and connect it directly to the computer.

« Ifthe USB cable is directly connected to the computer, try plugging it into
another USB port on the computer.

If there are other USB devices connected to the computer, disconnect the other

devices, except for the keyboard and the mouse.

Check the USB cable to make sure it is functioning properly.

Bf NOTE: If you are using an older cable, it might not be working properly. Try
connecting it to another product to see if the USB cable works. If you
experience problems, the USB cable might need to be replaced. Also verify
that the cable does not exceed 3 meters (9.8 feet) in length.

If another USB cable is available, try using that one instead.
Restart the computer.

. After the computer restarts, try to scan again.

Cause: The power cord or USB cable was not attached properly.
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If this did not solve the issue, try the next solution.

Solution 3: Restart the computer
Solution: Restart the computer.

Cause: You might not have restarted the computer after installing the product
software. Or, there might have been another problem with the computer.

If this did not solve the issue, try the next solution.
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Solution 4: Uninstall and reinstall the product

Solution: Uninstall the product from the Printers and Faxes control panel and then
reinstall it.

To uninstall and reinstall the product

1. Disconnect the USB cable between the product and the computer.
2. On the Windows taskbar, click Start, Printers and Faxes.

3. Right-click the product and select Delete.
4

Wait several seconds, and then reconnect the product to the computer with the
USB cable.

5. Follow any onscreen prompts to reinstall the product.
Cause: There might have been a problem when you originally installed the product.
If this did not solve the issue, try the next solution.

Solution 5: Uninstall and reinstall the HP Photosmart Software

Solution: Uninstall the complete HP Photosmart Software from the computer and
then reinstall it using the CD that came with your product.

To uninstall and reinstall the software

1. On the Windows taskbar, click Start, Settings, Control Panel.

2. Double-click Add/Remove Programs.

3. Remove all the items that are related to the HP scanning software.

A message appears on the computer to restart after removing some programs
from the Add/Remove Programs list.

4. Select Click here to restart later.
5. Disconnect the product from your computer and then restart your computer.

Bf NOTE: Itis important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.
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Insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.

BY NOTE: If the Setup program does not appear, locate the setup.exe file on
the CD-ROM drive and double-click it.

Follow the onscreen instructions and the instructions provided in the Setup Guide

that came with the product.

8. If you are still having trouble scanning, remove the following additional
applications from the Add/Remove Programs list, if they are present.

/\ CAUTION: I[f the computer is manufactured by HP or Compaq, do not

Cause:
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remove any applications other than those listed below.

HP Imaging device functions

HP Document Viewer

HP Photosmart Essential

HP Image Zone

HP Photo and imaging gallery

HP Photosmart, Officejet, Deskjet, (with product name and software version
number)

HP Software update

HP Share to web

HP Solution Center

HP Director

HP Memories Disk Greeting Card Creator 32

There might have been a problem when you originally installed the

HP Photosmart Software.

Product could not find available scan destinations

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

¢ Solution 1: Restart the computer

e Solution 2: Uninstall and reinstall the HP Photosmart Software

Solution 1: Restart the computer

Solution: Restart the computer.

Cause: You might not have restarted the computer after installing the product
software. Or, there might have been another problem with the computer.

If this did not solve the issue, try the next solution.
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166

Solution 2: Uninstall and reinstall the HP Photosmart Software

Solution: Uninstall the complete HP Photosmart Software from the computer and
then reinstall it using the CD that came with your product.

To uninstall and reinstall the software

1.
2,
3.

On the Windows taskbar, click Start, Settings, Control Panel.
Double-click Add/Remove Programs.
Remove all the items that are related to the HP scanning software.

A message appears on the computer to restart after removing some programs
from the Add/Remove Programs list.

Select Click here to restart later.
Disconnect the product from your computer and then restart your computer.

Bf NOTE: Itis important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.

Insert the HP Photosmart CD-ROM into your computer's CD-ROM drive and then
start the Setup program.

EY NOTE: If the Setup program does not appear, locate the setup.exe file on
the CD-ROM drive and double-click it.

Follow the onscreen instructions and the instructions provided in the Setup Guide
that came with the product.

If you are still having trouble scanning, remove the following additional
applications from the Add/Remove Programs list, if they are present.

/\ CAUTION: If the computer is manufactured by HP or Compaq, do not
remove any applications other than those listed below.

* HP Imaging device functions
* HP Document Viewer

* HP Photosmart Essential

* HP Image Zone

* HP Photo and imaging gallery

» HP Photosmart, Officejet, Deskjet, (with product name and software version
number)

* HP Software update

* HP Share to web

* HP Solution Center

* HP Director

* HP Memories Disk Greeting Card Creator 32

Cause: There might have been a problem when you originally installed the
HP Photosmart Software.
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Required software component was not found or was incorrectly installed

Solution: Uninstall the complete HP Photosmart Software from the computer and
then reinstall it using the CD that came with your product.

To uninstall and reinstall the software

1. On the Windows taskbar, click Start, Settings, Control Panel.

2. Double-click Add/Remove Programs.

3. Remove all the items that are related to the HP scanning software.

A message appears on the computer to restart after removing some programs
from the Add/Remove Programs list.

4. Select Click here to restart later.
5. Disconnect the product from your computer and then restart your computer.
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Br NOTE: Itis important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.

6. Insertthe HP Photosmart CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.

BY NOTE: If the Setup program does not appear, locate the setup.exe file on
the CD-ROM drive and double-click it.

7. Follow the onscreen instructions and the instructions provided in the Setup Guide
that came with the product.

8. If you are still having trouble scanning, remove the following additional
applications from the Add/Remove Programs list, if they are present.

/\ CAUTION: If the computer is manufactured by HP or Compaq, do not
remove any applications other than those listed below.

» HP Imaging device functions
+ HP Document Viewer

* HP Photosmart Essential

+ HP Image Zone

+ HP Photo and imaging gallery

+ HP Photosmart, Officejet, Deskjet, (with product name and software version
number)

* HP Software update

* HP Share to web

* HP Solution Center

* HP Director

+ HP Memories Disk Greeting Card Creator 32

Cause: There might have been a problem when you originally installed the
HP Photosmart Software.
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Error occurred while communicating with the product

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

* Solution 1: Reset the product

» Solution 2: Check the power cord and USB cable

+ Solution 3: Restart the computer

»  Solution 4: Uninstall and reinstall the product

» Solution 5: Uninstall and reinstall the HP Photosmart Software

» Solution 6: Contact HP support for service
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Solution 1: Reset the product

Solution: Turn off the product and reset it by disconnecting the power cord. Wait
60 seconds, and then plug in the power cord. Turn on the product.

Cause: You needed to reset the product.
If this did not solve the issue, try the next solution.

Solution 2: Check the power cord and USB cable

Solution: Make sure that the power cord and USB cable are properly attached and
plugged in. Also, make sure that the product is turned on.

To check the power supply

1. Make sure the power cord is firmly connected to both the product and the power
adaptor. Plug the power cord into a power outlet, surge protector, or power strip.

1 | Power connection

Power cord and adaptor

Power outlet
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Make sure the product is turned on.

If the product is not receiving electrical power, connect it to another power outlet.
Turn off the product and reset it by disconnecting the power cord.

5. Wait 5 seconds, and plug in the power cord.

6. Turn on the product.

7. Try to scan again.

Eall

To check the USB connection

1. Verify that the USB cable is securely plugged into the USB port on the back of
the product.

2. Make sure the other end of the USB cable is plugged into a USB port on your
computer.
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3. Try to scan again.

If the scan fails, continue to the next step.

4. Do one of the following, depending upon how the product is connected to the
computer:

» If the USB cable is connected to a USB hub, try unplugging and replugging
the USB cable into the hub. If that does not work, try turning off the hub and
then turning it on again. Finally, try disconnecting the cable from the hub and
connecting it directly to the computer.

« Ifthe USB cable is connected to a docking station for a laptop, disconnect the
cable from the docking station and connect it directly to the computer.

« Ifthe USB cable is directly connected to the computer, try plugging it into
another USB port on the computer.

5. |If there are other USB devices connected to the computer, disconnect the other
devices, except for the keyboard and the mouse.
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6. Check the USB cable to make sure it is functioning properly.

E¥ NOTE: If you are using an older cable, it might not be working properly. Try
connecting it to another product to see if the USB cable works. If you
experience problems, the USB cable might need to be replaced. Also verify
that the cable does not exceed 3 meters (9.8 feet) in length.

7. If another USB cable is available, try using that one instead.
8. Restart the computer.
9. After the computer restarts, try to scan again.

Cause: The power cord or USB cable was not attached properly.
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If this did not solve the issue, try the next solution.

Solution 3: Restart the computer
Solution: Restart the computer.

Cause: You might not have restarted the computer after installing the product
software. Or, there might have been another problem with the computer.

If this did not solve the issue, try the next solution.

Solution 4: Uninstall and reinstall the product

Solution: Uninstall the product from the Printers and Faxes control panel and then
reinstall it.

To uninstall and reinstall the product

1. Disconnect the USB cable between the product and the computer.
2. On the Windows taskbar, click Start, Printers and Faxes.

3. Right-click the product and select Delete.
4

Wait several seconds, and then reconnect the product to the computer with the
USB cable.

5. Follow any onscreen prompts to reinstall the product.
Cause: There might have been a problem when you originally installed the product.
If this did not solve the issue, try the next solution.

Solution 5: Uninstall and reinstall the HP Photosmart Software

Solution: Uninstall the complete HP Photosmart Software from the computer and
then reinstall it using the CD that came with your product.

To uninstall and reinstall the software

1. On the Windows taskbar, click Start, Settings, Control Panel.
2. Double-click Add/Remove Programs.
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3. Remove all the items that are related to the HP scanning software.
A message appears on the computer to restart after removing some programs
from the Add/Remove Programs list.

4. Select Click here to restart later.
5. Disconnect the product from your computer and then restart your computer.

Br NOTE: Itisimportant that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.

6. Insertthe HP Photosmart CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.
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BY NOTE: If the Setup program does not appear, locate the setup.exe file on
the CD-ROM drive and double-click it.

7. Follow the onscreen instructions and the instructions provided in the Setup Guide
that came with the product.

8. If you are still having trouble scanning, remove the following additional
applications from the Add/Remove Programs list, if they are present.

/\ CAUTION: If the computer is manufactured by HP or Compaq, do not
remove any applications other than those listed below.

» HP Imaging device functions
* HP Document Viewer

* HP Photosmart Essential

+ HP Image Zone

+ HP Photo and imaging gallery

+ HP Photosmart, Officejet, Deskjet, (with product name and software version
number)

* HP Software update

* HP Share to web

* HP Solution Center

* HP Director

+ HP Memories Disk Greeting Card Creator 32

Cause: There might have been a problem when you originally installed the
HP Photosmart Software.

If this did not solve the issue, try the next solution.

Solution 6: Contact HP support for service

Solution: If you have completed all of the steps provided in the previous solutions
and are still having a problem, contact HP support for service.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for technical
support.
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Cause: You might need assistance to enable the product or software to function
properly.

File messages
The following is a list of file-related error messages:
» Error reading or writing the file
» File not found
» File format not supported
* Invalid file name
»  Supported file types for the HP All-in-One
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Error reading or writing the file
Solution: Check to see if you have the right folder and file name.
Cause: The product software could not open or save the file.

File not found
Solution: Close some applications and try the task again.

Cause: There was not enough available memory on your computer to create a print
preview file.

File format not supported

Solution: Open the file in another application, and save it in a format that the
product software recognizes.

For more information, see:

Supported file types for the HP All-in-One

Cause: The product software did not recognize or support the file format of the
image you are trying to open or save. If the file extension indicates it is a supported
file type, the file might be corrupted.

Invalid file name
Solution: Make sure that you are not using any invalid symbols in the file name.

Cause: The file name you entered was invalid.
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Supported file types for the HP All-in-One
Refer to the following for the supported file formats:

General user messages
The following is a list of messages related to common user errors:

The HP Photosmart software supports the following file formats: BMP, DCX, FPX,
GIF, JPG, PCD, PCX, TIF, PICT, PSD, PCS, EPS, TGA, SGI, PDF, and PNG

When scanning, the HP Photosmart Software enables you to save an image in the
following file formats: BMP, DCX, FPX, GIF, JPG, PCD, PCX, and TIF

Cannot crop
Disconnected

No scan options
Out of disk space
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Cannot crop

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

Solution 1: Close applications that are not being used
Solution 2: Create more space on your hard drive

Solution 1: Close applications that are not being used

Solution: Close all applications that are not in use. This includes applications that
run in the background, such as screen savers and virus checkers. If you turn off your
virus checker, remember to turn it back on after you finish your scan.

If this problem occurs frequently, or if you encounter memory problems while using
other applications, you might need to add more memory to your computer. See the
user guide that came with your computer for more information.

Cause: The computer does not have enough memory.

Solution 2: Create more space on your hard drive

Solution: Empty the Recycle Bin on your desktop. You might also need to remove
files from the hard disk; for example, delete temporary files.

Cause: For scanning, there must be at least 50 MB of space available on your
computer's hard disk.

Disconnected

Solution: Make sure your computer is turned on and is connected to the product.
Also make sure you installed the software that came with the product.

For more information, see:
After setting up the product, it does not print
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Cause: Several situations can cause this error message to appear.

*  Your computer was not turned on.

* Your computer was not connected to the product.

« The software that came with the product was not installed correctly.

+  The software that came with the product is installed, but it was not running.

No scan options

Solution: Make sure the software is installed and running. For more information,
see the Setup Guide that came with the HP All-in-One.

Cause: The software that came with the product was not running, or has never been
installed.

Out of disk space

Solution: Close some applications and try the task again.

Cause: There was not enough available memory on your computer to perform the
task.

Paper messages

174

The following is a list of paper-related error messages:

Cannot load paper from input tray

Ink is drying
Out of paper
Paper jam or misfeed

Paper mismatch
Wrong paper width

Cannot load paper from input tray

Solution: If the product is out of paper or there are only a few sheets remaining,

load more paper in the input tray. If there is paper in the input tray, remove the paper,
gently tap the stack of paper against a flat surface, and reload the paper into the input
tray. To continue your print job, press any button on the control panel of the product.

Cause: There was not enough paper in the input tray.

Ink is drying

Solution: Leave the sheet in the output tray until the message disappears. Ifit is
necessary to remove the printed sheet before the message disappears, carefully hold
the printed sheet on the underside or the edges, and place it on a flat surface to dry.

Cause: Transparencies and some other media require a drying time that is longer
than normal.
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Out of paper

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Replace the rear door of the product

» Solution 2: Check the paper type and the print settings

» Solution 3: Clean the rollers

» Solution 4: Contact HP support

Solution 1: Replace the rear door of the product

Solution: If you removed the rear door to clear a paper jam, replace it. Gently push
the door forward until it snaps into place.
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Cause: The rear door was removed from the product.
If this did not solve the issue, try the next solution.

Solution 2: Check the paper type and the print settings
Solution: Check the paper loaded in the input tray and the print settings.

To check the paper in the input tray

1. Remove the stack of paper from the input tray and verify that all the paper in the
input tray is the same size and type.

2. Replace any paper that is ripped, dusty, wrinkled, or bent.
If the paper is curled, uncurl the paper by gently bending it in the opposite direction
of the curl or replace the paper.

BY NOTE: Use plain paper in the product until the issue is resolved.

3. Tap the stack of paper on a flat surface to align the edges.
4. Verify that the stack of paper contains between 10 and 25 sheets of paper.
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5. Insert the stack of paper into the input tray with the short edge forward and the
print side down. Slide the stack of paper forward until it stops.
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6. Slide the paper-width guide inward until it stops at the edge of the paper.

Bf NOTE: Do not overload in the input tray; make sure the stack of paper fits
within the input tray and is no higher than the top of the paper-width guide.

7. Make sure the print settings, paper size and type, match the paper loaded in the
input tray.
See the following tasks for information about checking and changing these
settings.

8. Try to print again.

To set the paper size

1. Make sure you have paper loaded in the input tray.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

Click the Features tab.
6. In the Resizing Options area, click the appropriate paper size from the Size list.

The following table lists the suggested paper size settings for the different types
of paper you can load in the input tray. Make sure to look at the long list of choices

o
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in the Size list to see if a defined paper size already exists for the type of paper
you are using.

Paper type

Suggested paper size settings

Copier, multi-purpose, or
plain papers

Letter or A4

Envelopes

Appropriate listed envelope size

Greeting-card papers

Letter or A4
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Index cards Appropriate listed card size (if listed sizes are not
appropriate, you can specify a custom paper size)

Inkjet papers Letter or A4

Iron-on T-shirt transfers Letter or A4

Labels Letter or A4

Legal Legal

Letterhead Letter or A4

Panorama photo paper

Appropriate listed panorama size (if listed sizes are not
appropriate, you can specify a custom paper size)

Photo papers

10 x 15 cm (4 x 6 inch), letter, A4, or an appropriate listed
size

Transparency films

Letter or A4

Custom-size papers

Custom paper size

To set the paper type for printing

Make sure you have paper loaded in the input tray.

On the File menu in your software application, click Print.
Make sure you have selected the correct printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

In the Basic Options area, click the appropriate paper type from the Paper

1.

2.

3.

4

5. Click the Features tab.
6.

Type list.
Cause:

settings did not match.

There was a problem with the paper loaded in the input tray, or the print

If this did not solve the issue, try the next solution.

Solution 3: Clean the rollers

Solution:

Clean the rollers.
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Make sure you have the following materials available:

« Lint-free cloth, or any soft material that will not come apart or leave fibers.
+ Distilled, filtered, or bottled water.

To clean the rollers
1. Turn off the product and remove the power cord.
2. Remove the rear access door.
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3. Dip the lint-free cloth into the purified or distilled water, and squeeze any excess
water from it.

4. Clean the rubber rollers to remove any dust or dirt buildup.

5. Replace the rear access door. Gently push the door forward until it snaps into
place.

6. Plug the power cord back in, and turn on the product.
7. Try to print again.

Cause: The rollers were dirty and needed to be cleaned.
If this did not solve the issue, try the next solution.

Solution 4: Contact HP support

Solution: If you have completed all of the steps provided in the previous solutions,
contact HP support for service.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for information
on calling for technical support.

Cause: Your product needs servicing.
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Paper jam or misfeed

Solution: Clear the paper jam.
For more information, see:

Clear paper jams
Cause: The HP All-in-One had a paper jam.

Paper mismatch

Solution: Change the print setting or load the appropriate paper in the input tray.
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For more information, see:

» Set the paper type for printing
* Choose papers for printing and copying

Cause: The print setting for the print job did not match the paper type or size loaded
in the product.

Wrong paper width

Solution: Change the print setting or load the appropriate paper in the input tray.
For more information, see:

+ Set the paper type for printing

» Choose papers for printing and copying

Cause: The print setting for the print job did not match the paper type or size loaded
in the product.

Power and connection messages
The following is a list of power- and connection-related error messages:

HP All-in-One not found
Communication test failed
Improper shutdown

Two-way communication lost
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HP All-in-One not found

Solution: If the product is not properly connected to the computer, communication
errors can occur. Make sure the USB cable is securely connected to the product and
the computer, as shown below.
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For more information, see:

After setting up the product, it does not print

Cause: This error applies only to USB-connected devices. The USB cable was not
plugged in properly.

Communication test failed

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

* Solution 1: Make sure the product is turned on

» Solution 2: Make sure the product is connected to the computer

Solution 1: Make sure the product is turned on

Solution: Look at the On button located on the product. If it is not lit, the product is
turned off. Make sure the power cord is firmly connected to the product and plugged
into a power outlet. Press the On button to turn on the product.

Cause: The product was turned off.

If this did not solve the issue, try the next solution.
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Solution 2: Make sure the product is connected to the computer

Solution: If the HP All-in-One is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the HP All-
in-One and the computer as shown below.
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For more information, see:
After setting up the product, it does not print

Cause: The computer was not communicating with the product.

Improper shutdown
Solution: Press the On button located on the control panel of the product to turn
the product on and off.
Cause: The last time the product was used, it was not turned off properly. If the
product is turned off by turning off the switch on a power strip or by using a wall switch,
the product can be damaged.

Two-way communication lost

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

» Solution 1: Make sure the product is turned on

» Solution 2: Make sure the product is connected to the computer

Solution 1: Make sure the product is turned on

Solution: Look at the On button located on the product. If it is not lit, the product is
turned off. Make sure the power cord is firmly connected to the product and plugged
into a power outlet. Press the On button to turn on the product.
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Cause: The product was turned off.
If this did not solve the issue, try the next solution.

Solution 2: Make sure the product is connected to the computer

Solution: If the product is not properly connected to the computer, communication
errors can occur. Make sure the USB cable is securely connected to the product and
the computer, as shown below.
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For more information, see:

After setting up the product, it does not print

Cause: The product was not connected to the computer.

Print cartridge messages
The following is a list of print cartridge error messages:

* Non-HP cartridges installed

* Previously used genuine HP cartridges installed

» Original HP ink has been depleted

* Lowonink

* Printing in ink-backup mode

» The print carriage is stalled

* Need alignment or alignment failed

»  Print cartridge is missing, incorrectly installed, or not intended for your product
» Print cartridges missing or not detected

* Incompatible print cartridges
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e Print cartridges in wrong slot
*  Print cartridge problem

Non-HP cartridges installed
Solution: Follow the prompts on the computer screen to continue or replace the
indicated print cartridges with genuine HP cartridges.

HP recommends that you use genuine HP print cartridges. Genuine HP print
cartridges are designed and tested with HP printers to help you easily produce great
results, time after time.

B NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using of a non-HP supply will not be
covered under warranty.
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If you believe you purchased genuine HP print cartridges, go to:

www.hp.com/go/anticounterfeit

For more information, see:
Replace the print cartridges
Cause: The product detected that a non-HP print cartridge was installed.

Previously used genuine HP cartridges installed

Solution: Check the print quality of the current print job. If it is satisfactory, follow
the prompts on the computer screen to continue.

Ink levels might not be available for the indicated print cartridges. Ink level warnings
and indicators provide estimates for planning purposes only. When you receive a low-
ink warning message, consider having a replacement cartridge available to avoid
possible printing delays. You do not need to replace the print cartridges until print
quality becomes unacceptable.

Cause: A genuine HP print cartridge was previously used in another printer.

Original HP ink has been depleted

Solution: Follow the prompts on the computer screen to continue or replace the
indicated print cartridges with genuine HP cartridges.

Ink levels might not be available for the indicated print cartridges. Ink level warnings
and indicators provide estimates for planning purposes only. When you receive a low-
ink warning message, consider having a replacement cartridge available to avoid
possible printing delays. You do not need to replace the print cartridges until print
quality becomes unacceptable.

Bf NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer
service or repairs required as a result of using of a non-HP supply will not be
covered under warranty.

If you believe you purchased genuine HP print cartridges, go to:

Errors 183


http://www.hp.com/go/anticounterfeit

Chapter 12

www.hp.com/go/anticounterfeit

For more information, see:

Replace the print cartridges

Cause: The original HP ink in the indicated print cartridges was depleted.

Low on ink

Solution: Inklevels might not be available for the indicated print cartridges. Ink level
warnings and indicators provide estimates for planning purposes only. When you
receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace the print
cartridges until print quality becomes unacceptable.
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For HP product return and recycling information, visit us at: www.hp.com/recycle.

Cause: The indicated print cartridges were estimated to be low on ink and might
need to be replaced soon.

Printing in ink-backup mode

Solution: If you receive the ink-backup mode message and two print cartridges are
installed in the product, verify that the protective piece of plastic tape has been
removed from each print cartridge. When plastic tape covers the print cartridge
contacts, the device cannot detect that the print cartridge is installed.

RN

Copper-colored contacts

Plastic tape with pink pull tab (must be removed before installing)

3 | Ink nozzles under tape

For more information, see Use ink-backup mode.

Cause: When the product detected that only one print cartridge is installed, ink-
backup mode is initiated. This printing mode lets you print with a single print cartridge,
but it slows the product and affects the quality of printouts.
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The print carriage is stalled

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.

+ Solution 1: Print a self-test report

» Solution 2: Clear the print carriage

» Solution 3: Check the power source

Solution 1: Print a self-test report
Solution: Print a self-test report to see if the product can print.
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To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Start Copy Color button.

The product prints a self-test report, which might indicate the source of the printing
problem. A sample of the ink test area of the report is shown below.

3. Make sure the test patterns show a complete grid and the thick color lines are

complete.

* If more than a few lines in a pattern are broken, this might indicate a problem
with the nozzles. You might need to clean the print cartridges.

« Ifthe black line is missing, faded, streaked, or shows lines, this might indicate
a problem with the black or photo print cartridge in the right slot.

» Ifany of the color lines are missing, faded, streaked, or show lines, this might
indicate a problem with the tri-color print cartridge in the left slot.

Cause: The error was false.
If this did not solve the issue, try the next solution.

Errors 185



Chapter 12

Solution 2: Clear the print carriage

Solution: Remove any objects, such as paper, that are blocking the print carriage.
Then reset the product.

To clear the print carriage
1. Make sure the product is on.
2. Open the print cartridge door.

The print carriage should move to the center of the product. If the print carriage
does not move to the center, turn the product off, and then on.
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3. Make note of where the print carriage is stuck and look for jammed paper.
A paper jam can cause the error message and the print carriage to stall.

/\ CAUTION: Do not use any tools or other devices to remove jammed paper.
Always use caution when removing jammed paper from inside the product.

If the print carriage is stuck on the right side
a. Check for any paper or object that might be restricting the print carriage.
b. Move the print carriage all the way to the left side.

c. Check the paper path all the way to the right side and remove any paper still
in the product.

If the print carriage is stuck on the left side
a. Check for any paper or object that may be restricting the print carriage.
b. Move the print carriage all the way to the right side.

c. Check the paper path all the way to the left side and remove any paper still
in the product.

If the print carriage is stuck in the middle
a. Check for any paper or object that may be restricting the print carriage.
b. Move the print carriage all the way to the left side.

c. Check the paper path all the way to the right side and remove any paper still
in the product.

Move the print carriage all the way to the right side.

e. Check the paper path all the way to the left side and remove any paper still
in the product.
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To check for a paper jam in the rear access door

a.

b.
c.

Close the print cartridge door.
Check for a paper jam in the rear access door.

Press in the tab on the rear access door to release the door. Remove the door
by pulling it away from the product.
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Check for any paper still in the product. Gently pull any paper out of the rollers.
Replace the rear access door. Gently push the door forward until it snaps into
place.

Do one of the following, depending upon the state of the product:

If the On button light is on and steady, print a self-test report. If you can print
a self-test report,